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About This Book

WARNING! Text set off in this manner indicates that failure to follow directions could result in bodily harm or 
loss of life.

CAUTION: Text set off in this manner indicates that failure to follow directions could result in damage to 
equipment or loss of information.

NOTE: Text set off in this manner provides important supplemental information.
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1 Product Features

Overview
The HP All-in-One Business PC offers the following features:

● Integrated All-in-One form factor

● 18.5-inch diagonal widescreen HD LED-backlight anti-glare LCD Display

● Adjustable tilt stand

● HP 205 G1 models: AMD E1-2500 processor featuring AMD Radeon HD 8240 Integrated Graphics

● HP 205 G2 models: AMD E1-6010 processor featuring AMD Radeon R2 Integrated Graphics

● HP 18 models: Intel Pentium J2900 or Intel Celeron J1800 processor

● Integrated Realtek RTL8166EH-CG 10/100 Ethernet Controller

● Wireless connectivity - HP WLAN/Bluetooth Combo NIC 802.11b/g/n Mini Card

● HP 205 G1 and HP 18 models: Integrated 1.0 MP 720p low-light webcam with microphone array

● HP 205 G2 models: Integrated VGA (640 x 480) webcam with mono microphone

● Integrated HD audio card and stereo speakers

● Up to 16 GB of DDR3 SDRAM supported

● Up to 2-TB hard drive

● Optional HP Slim-Tray SuperMulti DVD+RW SATA 8X Optical Drive

● 7-in-1 Media Card Reader

● USB Keyboard and Mouse

● ENERGY STAR® (for Windows operating system only)

● EPEAT® Silver certification

Where HP registers commercial desktop products. See http://www.epeat.net for registration status in 
your country

Overview 1
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Front components

Component Component

1 Internal microphones (2) 3 Webcam

2 Webcam light 4 Speaker

Top components

Component  

5 Power button   
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Right components

Component  

6 Optical drive   
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Left components

Component Component

7 Drive light 10 Audio-in (microphone) jack

8 Memory card reader 11 Audio-out (headphone) jack

9 USB 3.0 ports (2)   
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Rear components

Component Component

12 Power connector 14 USB ports (4)

13 RJ-45 (network) jack 15 Audio line-out jack

Rear components 5



2 Activating and Customizing the Software

Activating and customizing the software in Windows 10
Additional information is available in online help after you activate the operating system.

NOTE: Be sure there is a 10.2 cm (4 inch) clearance at the back of the unit and above the monitor to permit 
the required airflow.

Activating the Windows Operating System

The first time you turn on the computer, the operating system is set up and activated automatically. This 
process takes about 5 to 10 minutes. Carefully read and follow the instructions on the screen to complete the 
activation.

We recommend that you register your computer with HP during operating system set up so you can receive 
important software updates, facilitate support questions, and sign up for special offers. You can also register 
your computer with HP using the Register with HP app on the Start screen.

CAUTION: After the activation process has begun, DO NOT TURN OFF THE COMPUTER UNTIL THE PROCESS IS 
COMPLETE. Turning off the computer during the activation process may damage the software that runs the 
computer or prevent its proper installation.

Downloading Windows updates

Microsoft may release updates to the operating system. To help keep the computer running optimally, HP 
recommends checking for the latest updates during the initial installation and periodically throughout the life 
of the computer.

Run Windows Update as soon as possible after you set up your computer.

1. From the taskbar, type Windows Update, and then from the Search window, select Check for 
updates.

2. Click Update & recovery, and then click Check for updates.

3. Run Windows Update monthly thereafter.

Customizing the monitor display

If you wish, you can select or change the monitor refresh rates, screen resolution, color settings, font sizes, 
and power management settings.

For more information, refer to the online documentation provided with the graphics controller utility or the 
documentation that came with your monitor.

▲ Right-click on the Windows desktop, then click Personalize or Screen resolution to change display 
settings.

– or –

Click the Start icon, click Settings, and the click Personalization.
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Activating and customizing the software in Windows 8.1
Additional information is available in online help after you activate the operating system.

NOTE: Be sure there is a 10.2 cm (4 inch) clearance at the back of the unit to permit the required airflow.

Activating the Windows Operating System

The first time you turn on the computer, the operating system is set up and activated automatically. This 
process takes about 5 to 10 minutes. Carefully read and follow the instructions on the screen to complete the 
activation.

We recommend that you register your computer with HP during operating system set up so you can receive 
important software updates, facilitate support questions, and sign up for special offers. You can also register 
your computer with HP using the Register with HP app on the Start screen.

CAUTION: After the activation process has begun, DO NOT TURN OFF THE COMPUTER UNTIL THE PROCESS IS 
COMPLETE. Turning off the computer during the activation process may damage the software that runs the 
computer or prevent its proper installation.

Downloading Windows 8.1 updates

Microsoft may release updates to the operating system. To help keep the computer running optimally, HP 
recommends checking for the latest updates during the initial installation and periodically throughout the life 
of the computer.

Run Windows Update as soon as possible after you set up your computer.

1. Point to the upper-right or lower-right corner of the Start screen to display the charms.

2. Click Settings > Change PC Settings > Windows Update.

3. Run Windows Update monthly thereafter.

Customizing the display

You can customize display settings for Windows 8.1 separately for the Start screen and the Desktop.

To customize the Start screen:

1. Point to the upper-right or lower-right corner of the Start screen to display the charms.

2. Click Settings > Change PC Settings.

3. Click Personalize to change the display settings.

To customize the Desktop:

1. Click the Desktop app on the Start screen.

2. Right-click on the desktop, and then click Personalize to change display settings.

Activating and customizing the software in Windows 8.1 7



3 Illustrated parts catalog

Boards and memory

Item Component Spare part number

(1) System board (includes processor and replacement thermal material):  

 For use in HP 205 G1 models:  

 ● AMD E1-2500 APU for use in models with Windows 7 or without the Windows operating 
system

751275-001

 ● AMD E1-2500 APU for use in models with Windows 8.1 Standard 751275-501

 ● AMD E1-2500 APU for use in models with Windows 8.1 Professional or Windows 10 751275-601

 For use in HP 205 G2 models:  

 ● AMD E1-6010 APU for use in models with Windows 7 or without the Windows operating 
system

806244-001

 ● AMD E1-6010 APU for use in models with Windows 8.1 Standard 806244-501

 ● AMD E1-6010 APU for use in models with Windows 8.1 Professional or Windows 10 806244-601

 For use in HP 18 models:  

 ● Intel Pentium J2900 processor for use in models with Windows 7 or without the Windows 
operating system

782107-001

 ● Intel Pentium J2900 processor for use in models with Windows 8.1 Standard 782107-501

 ● Intel Pentium J2900 processor for use in models with Windows 8.1 Professional or 
Windows 10

782107-601

 ● Intel Celeron J1800 processor for use in models with Windows 7 or without the Windows 
operating system

782108-001

 ● Intel Celeron J1800 processor for use in models with Windows 8.1 Standard 782108-501
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Item Component Spare part number

 ● Intel Celeron J1800 processor for use in models with Windows 8.1 Professional or 
Windows 10

782108-601

(2) Converter board 751276-001

(3) Power button board 752342-001

 WLAN module  

 For use in HP 205 G1 and HP 18 models:  

 ● Ralink RT5390R 802.11bgn Wi-Fi Adapter 701399-001

 For use in HP 205 G2 models:  

 ● HP Broadcom BCM943142HM 802.11 b/g/n WLAN + BT4.0 Mini Wireless Card 753076-001

 ● Ralink RT5390R 802.11bgn Wi-Fi Adapter for use only in Brazil 806249-201

 Wireless antenna kit 806248-001

 Webcam  

 HD, for use in HP 205 G1 and HP 18 models 752344-001

 VGA, for use in HP 205 G2 and HP 18 models 806245-001

 Memory module (PC3L-12800, 1666-MHz, DDR3):  

 4-GB 689373-001

 2-GB 689372-001

Mass storage devices

Item Spare part number

Hard drives

2-TB, 7200 rpm 616608-001

750-MB, 7200 rpm 639363-001

500-MB, 7200 rpm 751283-001

Optical drive

DVD±RW drive 657958-001

Optical drive bezel 806247-001

Mass storage devices 9



Miscellaneous parts

Item Component Spare part number

(1) Speakers 752343-001

(2) Hard drive screw bumpers 752334-001

(3) Fan 752335-001

(4) Front bezel 752331-001

 Rear cover 752332-001

 Display panel, 18.5-inch, anti-glare , LED N-ZBD, 200 nits 752345-001

 Stand 752333-001

 AC adapter (65 W)  

 Standard efficiency 752346-001

 89% efficient 806246-001

 Mouse, USB  

 Mouse, USB 719901-001

 Mouse, USB, optical 674316-001

 Keyboards, unbranded  

 Brazilian Portuguese 709695-161

 Chinese 729339-AA1

 French Canadian 709695-121

 International English 709695-L31

 Latin American Spanish 537924-161

 United States 729339-001
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Cables

Component Spare part number

Backlight cable 752330-001

Power button board cable 752336-001

Webcam cable 752337-001

Hard drive cable assembly 752338-001

Optical drive cable assembly 752339-001

LVDS (display) cable 752340-001

Converter board cable 752341-001

Cables 11



4 Serial ATA (SATA) drive guidelines and 
routine care and disassembly preparation

This chapter provides general service information for the computer. Adherence to the procedures and 
precautions described in this chapter is essential for proper service.

CAUTION: When the computer is plugged into an AC power source, voltage is always applied to the system 
board. You must disconnect the power cord from the power source before opening the computer to prevent 
system board or component damage. 

NOTE: HP only supports the use of SATA hard drives on these models of computer. No Parallel ATA (PATA) 
drives are supported. 

SATA hard drives

Serial ATA Hard Drive Characteristics  

Number of pins/conductors in data cable 7/7

Number of pins in power cable 15

Maximum data cable length 39.37 in (100 cm)

Data interface voltage differential 400-700 mV

Drive voltages 3.3 V, 5 V, 12 V

Jumpers for configuring drive N/A

Data transfer rate 6.0 Gb/s

SATA hard drive cables

SATA data cable

Always use an HP approved SATA 3.0 Gb/s cable as it is fully backwards compatible with the SATA 1.5 Gb/s 
drives.

Current HP desktop products ship with SATA 3.0 Gb/s hard drives.

SATA data cables are susceptible to damage if overflexed. Never crease a SATA data cable and never bend it 
tighter than a 30 mm (1.18 in) radius.

The SATA data cable is a thin, 7-pin cable designed to transmit data for only a single drive.
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SMART ATA drives
The Self Monitoring Analysis and Recording Technology (SMART) ATA drives for the HP Personal Computers 
have built-in drive failure prediction that warns the user or network administrator of an impending failure or 
crash of the hard drive. The SMART drive tracks fault prediction and failure indication parameters such as 
reallocated sector count, spin retry count, and calibration retry count. If the drive determines that a failure is 
imminent, it generates a fault alert.

Electrostatic discharge information
A sudden discharge of static electricity from your finger or other conductor can destroy static-sensitive 
devices or microcircuitry. Often the spark is neither felt nor heard, but damage occurs. An electronic device 
exposed to electrostatic discharge (ESD) may not appear to be affected at all and can work perfectly 
throughout a normal cycle. The device may function normally for a while, but it has been degraded in the 
internal layers, reducing its life expectancy.

Networks built into many integrated circuits provide some protection, but in many cases, the discharge 
contains enough power to alter device parameters or melt silicon junctions.

Generating static

The following table shows that:

● Different activities generate different amounts of static electricity.

● Static electricity increases as humidity decreases.

 Relative Humidity

Event 55% 40% 10%

Walking across carpet

Walking across vinyl floor

Motions of bench worker

Removing DIPs* from plastic tube

7,500 V

3,000 V

400 V

400 V

15,000 V

5,000 V

800 V

700 V

35,000 V

12,000 V

6,000 V

2,000 V

Removing DIPs* from vinyl tray

Removing DIPs* from Styrofoam

Removing bubble pack from PCB

Packing PCBs in foam-lined box

2,000 V

3,500 V

7,000 V

5,000 V

4,000 V

5,000 V

20,000 V

11,000 V

11,500 V

14,500 V

26,500 V

21,000 V

*These are then multi-packaged inside plastic tubes, trays, or Styrofoam.

NOTE: 700 volts can degrade a product.

Preventing electrostatic damage to equipment

Many electronic components are sensitive to ESD. Circuitry design and structure determine the degree of 
sensitivity. The following packaging and grounding precautions are necessary to prevent damage to electric 
components and accessories.

● To avoid hand contact, transport products in static-safe containers such as tubes, bags, or boxes.

● Protect all electrostatic parts and assemblies with conductive or approved containers or packaging.

SMART ATA drives 13



● Keep electrostatic sensitive parts in their containers until they arrive at static-free stations.

● Place items on a grounded surface before removing them from their container.

● Always be properly grounded when touching a sensitive component or assembly.

● Avoid contact with pins, leads, or circuitry.

● Place reusable electrostatic-sensitive parts from assemblies in protective packaging or conductive 
foam.

Personal grounding methods and equipment

Use the following equipment to prevent static electricity damage to equipment:

● Wrist straps are flexible straps with a maximum of one-megohm ± 10% resistance in the ground cords. 
To provide proper ground, a strap must be worn snug against bare skin. The ground cord must be 
connected and fit snugly into the banana plug connector on the grounding mat or workstation.

● Heel straps/Toe straps/Boot straps can be used at standing workstations and are compatible with 
most types of shoes or boots. On conductive floors or dissipative floor mats, use them on both feet with 
a maximum of one-megohm ± 10% resistance between the operator and ground.

Static Shielding Protection Levels

Method Voltage

Antistatic plastic

Carbon-loaded plastic

Metallized laminate

1,500

7,500

15,000

Grounding the work area

To prevent static damage at the work area, use the following precautions:

● Cover the work surface with approved static-dissipative material. Provide a wrist strap connected to the 
work surface and properly grounded tools and equipment.

● Use static-dissipative mats, foot straps, or air ionizers to give added protection.

● Handle electrostatic sensitive components, parts, and assemblies by the case or PCB laminate. Handle 
them only at static-free work areas.

● Turn off power and input signals before inserting and removing connectors or test equipment.

● Use fixtures made of static-safe materials when fixtures must directly contact dissipative surfaces.

● Keep work area free of nonconductive materials such as ordinary plastic assembly aids and Styrofoam.

● Use field service tools, such as cutters, screwdrivers, and vacuums, that are conductive.

Recommended materials and equipment

Materials and equipment that are recommended for use in preventing static electricity include:

● Antistatic tape

● Antistatic smocks, aprons, or sleeve protectors

● Conductive bins and other assembly or soldering aids
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● Conductive foam

● Conductive tabletop workstations with ground cord of one-megohm +/- 10% resistance

● Static-dissipative table or floor mats with hard tie to ground

● Field service kits

● Static awareness labels

● Wrist straps and footwear straps providing one-megohm +/- 10% resistance

● Material handling packages

● Conductive plastic bags

● Conductive plastic tubes

● Conductive tote boxes

● Opaque shielding bags

● Transparent metallized shielding bags

● Transparent shielding tubes

Operating guidelines
To prevent overheating and to help prolong the life of the computer:

● Keep the computer away from excessive moisture, direct sunlight, and extremes of heat and cold.

● Operate the computer on a sturdy, level surface. Leave a 10.2-cm (4-inch) clearance on all vented sides 
of the computer to permit the required airflow.

● Occasionally clean the air vents on all vented sides of the computer. Lint, dust, and other foreign matter 
can block the vents and limit the airflow. Be sure to unplug the computer before cleaning the air vents.

● Never operate the computer with the cover removed.

● Do not place computers so near each other that they are subject to each other’s re-circulated or 
preheated air.

● Keep liquids away from the computer and keyboard.

● Install or enable power management functions of the operating system or other software, including 
sleep states.

Routine care

General cleaning safety precautions

1. Never use solvents or flammable solutions to clean the computer.

2. Never immerse any parts in water or cleaning solutions; apply any liquids to a clean cloth and then use 
the cloth on the component.

3. Always unplug the computer when cleaning with liquids or damp cloths.

4. Always unplug the computer before cleaning the keyboard, mouse, or air vents.
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5. Disconnect the keyboard before cleaning it.

6. Wear safety glasses equipped with side shields when cleaning the keyboard.

Cleaning the computer case

Follow all safety precautions in General cleaning safety precautions on page 15 before cleaning the computer.

To clean the computer case, follow the procedures described below:

● To remove light stains or dirt, use plain water with a clean, lint-free cloth or swab.

● For stronger stains, use a mild dishwashing liquid diluted with water. Rinse well by wiping it with a cloth 
or swab dampened with clear water.

● For stubborn stains, use isopropyl (rubbing) alcohol. No rinsing is needed as the alcohol will evaporate 
quickly and not leave a residue.

● After cleaning, always wipe the unit with a clean, lint-free cloth.

● Occasionally clean the air vents on the computer. Lint and other foreign matter can block the vents and 
limit the airflow.

Cleaning the keyboard

Follow all safety precautions in General cleaning safety precautions on page 15 before cleaning the keyboard.

To clean the tops of the keys or the keyboard body, follow the procedures described in Cleaning the computer 
case on page 16.

When cleaning debris from under the keys, review all rules in General cleaning safety precautions on page 15 
before following these procedures:

CAUTION: Use safety glasses equipped with side shields before attempting to clean debris from under the 
keys. 

● Visible debris underneath or between the keys may be removed by vacuuming or shaking.

● Canned, pressurized air may be used to clean debris from under the keys. Caution should be used as too 
much air pressure can dislodge lubricants applied under the wide keys.

● If you remove a key, use a specially designed key puller to prevent damage to the keys. This tool is 
available through many electronic supply outlets.

CAUTION: Never remove a wide leveled key (like the space bar) from the keyboard. If these keys are 
improperly removed or installed, the keyboard may not function properly.

● Cleaning under a key may be done with a swab moistened with isopropyl alcohol and squeezed out. Be 
careful not to wipe away lubricants necessary for proper key functions. Use tweezers to remove any 
fibers or dirt in confined areas. Allow the parts to air dry before reassembly.

Cleaning the display

● Wipe the display screen with a clean cloth moistened with water or with a towelette designed for 
cleaning displays. Do not use sprays or aerosols directly on the screen; the liquid may seep into the 
housing and damage a component. Never use solvents or flammable liquids.
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Cleaning the mouse

Before cleaning the mouse, ensure that the power to the computer is turned off.

● Clean the mouse ball by first removing the retaining plate and the ball from the housing. Pull out any 
debris from the ball socket and wipe the ball with a clean, dry cloth before reassembly.

● To clean the mouse body, follow the procedures in Cleaning the computer case on page 16.

Service considerations
Listed below are some of the considerations that you should keep in mind during the disassembly and 
assembly of the computer.

Tools and software requirements

To service the computer, you need the following:

● Torx T-15 screwdriver (HP screwdriver with bits, PN 161946-001)

● Flat-bladed screwdriver (may sometimes be used in place of the Torx screwdriver)

● Phillips #2 screwdriver

● Diagnostics software

● HP tamper-resistant T-15 wrench (Smart Cover FailSafe Key, PN 166527-001) or HP tamper-resistant 
bits (Smart Cover FailSafe Key, PN 166527-002)

Screws

The screws used in the computer are not interchangeable. They may have standard or metric threads and may 
be of different lengths. If an incorrect screw is used during the reassembly process, it can damage the unit. HP 
strongly recommends that all screws removed during disassembly be kept with the part that was removed, 
then returned to their proper locations.

CAUTION: As each subassembly is removed from the computer, it should be placed away from the work area 
to prevent damage.
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Cables and connectors

Most cables used throughout the unit are flat, flexible cables. These cables must be handled with care to 
avoid damage. Apply only the tension required to seat or unseat the cables during insertion or removal from 
the connector. Handle cables by the connector whenever possible. In all cases, avoid bending or twisting the 
cables, and ensure that the cables are routed in such a way that they cannot be caught or snagged by parts 
being removed or replaced.

CAUTION: When servicing this computer, ensure that cables are placed in their proper location during the 
reassembly process. Improper cable placement can damage the computer. 

Hard drives

Handle hard drives as delicate, precision components, avoiding all physical shock and vibration. This applies 
to failed drives as well as replacement spares.

● If a drive must be mailed, place the drive in a bubble-pack mailer or other suitable protective packaging 
and label the package “Fragile: Handle With Care.”

● Do not remove hard drives from the shipping package for storage. Keep hard drives in their protective 
packaging until they are actually mounted in the CPU.

● Avoid dropping drives from any height onto any surface.

● If you are inserting or removing a hard drive, turn off the computer. Do not remove a hard drive while the 
computer is on or in standby mode.

● Before handling a drive, ensure that you are discharged of static electricity. While handling a drive, avoid 
touching the connector. For more information about preventing electrostatic damage, refer to 
Electrostatic discharge information on page 13

● Do not use excessive force when inserting a drive.

● Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic fields 
such as displays or speakers.

Lithium coin cell battery

The battery that comes with the computer provides power to the real-time clock and has a minimum lifetime 
of about three years.

See the appropriate removal and replacement chapter for the chassis you are working on in this guide for 
instructions on the replacement procedures.

WARNING! This computer contains a lithium battery. There is a risk of fire and chemical burn if the battery is 
handled improperly. Do not disassemble, crush, puncture, short external contacts, dispose in water or fire, or 
expose it to temperatures higher than 140ºF (60ºC). Do not attempt to recharge the battery.

NOTE: Batteries, battery packs, and accumulators should not be disposed of together with the general 
household waste. In order to forward them to recycling or proper disposal, please use the public collection 
system or return them to HP, their authorized partners, or their agents.
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5 Removal and Replacement Procedures All-
in One (AIO) Chassis

The following sections provide information about disassembling various components of the computer.

Preparing to disassemble the computer
To avoid injury and equipment damage, always complete the following steps in order, when opening the HP 
Pro All-in-One.

1. Remove all media from the computer.

2. Shut down the computer.

3. After the system has completely shut down, disconnect the power adapter from the back of the 
computer.

4. Disconnect all other attached cables from the back of the computer.

5. Place the computer face down on a soft flat surface. HP recommends that you set down a blanket, towel, 
or other soft cloth to protect the screen surface from scratches or other damage.

WARNING! Beware of sharp edges inside the chassis.
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Rear cover

Description Spare part number

Rear cover 752332-001

The computer has one main rear cover that allows access to internal components.

To remove the rear cover:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 19).

2. On the bottom of the computer, turn the two captive screws (1) to the left until they click and release 
the rear cover.

3. Lift up on the bottom of the rear cover to disengage it (2), and then lift the rear cover off the computer 
(3).

To replace the rear cover, reverse the removal procedures.
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Stand assembly

Description Spare part number

Stand assembly 752333-001

The stand is secured with four Torx screws. You must remove the rear cover to remove the stand.

To remove the stand:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 19).

2. Remove the rear cover (see Rear cover on page 20).

3. On the side of the rear cover, in the order stamped into the stand, remove the four Torx screws that 
secure the stand to the rear cover (1).

4. Remove the stand from the rear cover (2).

To replace the stand, reverse the removal procedures.
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Webcam module

Description Spare part number

Webcam module, HD, for use in HP 205 G1 and HP 18 models 752344-001

Webcam module, VGA, for use in HP 205 G2 models 806245-001

On products that ship with a webcam module, the module is located at the top of the computer beneath the 
top panel. It is secured with two silver Phillips screws and has one connector.

The webcam module is optional.

To remove the webcam module:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 19).

2. Remove the rear cover (see Rear cover on page 20).

3. Press the tabs on each side of the webcam module and lift it up away from the tabs.

22 Chapter 5   Removal and Replacement Procedures All-in One (AIO) Chassis



4. Rotate the assembly to gain access to the connector on the module, and then disconnect the cable from 
the module.

5. To remove the module from the bracket, remove the two Phillips screws that secure the module, and 
then separate the module from the bracket.

To install a webcam module, reverse the removal procedures.

Replacing drives

Replacing the hard disc drive with a 3.5-inch drive or a 2.5-inch drive

Description Spare part number

2-TB, 7200 rpm hard drive 616608-001

750-GB, 7200 rpm hard drive 639363-001

500-GB, 7200 rpm hard drive 751283-001

Hard drive screw bumper 752334-001

The hard disc drive is located on the left side of the computer (when viewed from behind). The drive is housed 
in a removable cage.

To install a 2.5-inch drive, you need a drive adapter.

The hard drive data cable connects to the SATA0 and SATA PWR0 system board connectors.

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 19).

2. Remove the rear cover (see Rear cover on page 20).

Replacing drives 23



3. Loosen the captive Phillips screw (1) that secures the hard drive cage to the computer, and then slide 
the cage toward the edge of the chassis to disengage it from the connector, and lift it out of the 
computer (2).

NOTE: Hard drive cage appearance may vary.

4. Both 3.5-inch and 2.5-inch hard drives are supported. A 2.5-inch hard drive requires an adapter to fit into 
the hard drive cage. To remove the hard drive, refer to the procedures below that correspond to the size 
of your drive:

3.5-inch hard drive:

▲ Remove the four Phillips screws (1) that secure the drive to the cage, and then slide the drive out 
of the cage (2).
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2.5-inch hard drive:

a. Remove the four Phillips screws (1) that secure the drive adapter to the cage, and then slide the 
drive out of the cage (2).

b. Remove the four Phillips screws that secure the drive to the adapter (1), and the slide the drive out 
of the adapter (2).

To replace the hard drive, reverse the removal procedures.

NOTE: To install an optional 2.5-inch drive, you must

1. Mount the drive in a drive adapter

2. Screw the four mounting screws into the drive adapter
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Replacing the optical disc drive

Description Spare part number

DVD±RW drive 657958-001

Optical drive bezel 806247-001

The optical disc drive is located above the hard disc drive on the left side of the computer (when viewed from 
behind).

The optical drive data cable connects to the SATA1 and SATA PWR1 system board connectors.

NOTE: The drive bracket is not spared. When replacing an optical drive, remove the bracket from the old 
drive and install it on the new drive.

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 19).

2. Remove the rear cover (see Rear cover on page 20).

3. Loosen the captive Phillips screw (1) that secures the hard drive cage to the computer, and then slide 
the cage toward the edge of the chassis to disengage it from the connector, and remove it from the 
computer (2).

NOTE: When replacing an optical drive, remove the bracket from the old drive and install it on the new 
drive. The bracket is not spared.
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4. Remove the two screws securing the optical disc drive bracket to the drive, and then remove the bracket.

To replace the optical drive, reverse the removal procedures.
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Front bezel

Description Spare part number

Front bezel 752331-001

The front bezel is secured to the main system bracket with seven Torx screws.

To remove the front bezel:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 19).

2. Remove the rear cover (see Rear cover on page 20).

3. Remove the speakers (see Speakers on page 34).

4. Remove the webcam (see Webcam module on page 22).

5. Disconnect the power button board cable.

6. Remove the seven Torx screws that secure the bezel to the computer (pointed out with arrows in the 
following illustration).
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7. Disengage the nine tabs that secure the bezel to the computer (pointed out with white circles in the 
following illustration).

NOTE: Although the following image shows the computer with most components removed, you can 
remove the bezel with all components installed except for the speakers.

8. Lift the computer from the bezel.

To install the front bezel, reverse the removal procedures.
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Converter board

Description Spare part number

Converter board 751276-001

The converter board is located on the left side of the computer (viewed from behind) under the main rear 
cover. It is secured with two Torx screws and has two connectors.

Use the same converter spare part for all display panels; however, you must change jumper settings on the 
board based on the display panel.

To remove the converter board:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 19).

2. Remove the rear cover (see Rear cover on page 20).

3. Disconnect the two cables from the board (1).

NOTE: Be careful not to damage the cables when disconnecting them from the board. Do not pull on 
the wires.

4. Remove the black Torx screw (2) that secures the board to the computer.
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5. Lift the converter board from the computer (3).

To install the converter board, reverse the removal procedures.
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Power button board

Description Spare part number

Power button board 752342-001

The power button board is located on the top left of the computer (when viewed from behind).

To remove the power button board:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 19).

2. Remove the rear cover (see Rear cover on page 20).

3. Remove the Torx screw that secures the bracket to the computer (1), and then lift the bracket off the 
computer (2).

4. Disconnect the cable from the power button board (1).
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5. Press on the tab that holds the power button board in place (2), and the remove the board from the 
computer.

To install the power button board, reverse the removal procedures.
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Speakers

Description Spare part number

Speakers 752343-001

The speakers are located at the bottom of the computer. Two separate speakers are each secured by two Torx 
screws.

To remove the speakers:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 19).

2. Remove the rear cover (see Rear cover on page 20).

3. Remove two Torx screws (1) that secure each speaker to the computer.

4. Disconnect the speaker cable from the system board connector labeled SPKR (2).

5. Remove the speakers from the computer.

To install the speakers, reverse the removal procedures.
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Fan

Description Spare part number

Fan 752335-001

The fan is located near the middle of the computer and is secured with three Torx screws. You have to remove 
the metal plate to remove the fan.

To remove the fan assembly:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 19).

2. Remove the rear cover (see Rear cover on page 20).

3. Remove the two Torx screws that secure the bracket to the computer (1), and then lift the bracket off 
the computer (2).

4. Remove the three Torx screws that secure the fan to the computer (1).

5. Remove the optical drive cable from the clips built into the fan (2).
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6. Disconnect the fan cable from the system board connector labeled CHFAN2 (3).

7. Remove the fan from the computer.

To install the fan assembly, reverse the removal procedures.
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Hard drive and optical drive cables and connectors

Description Spare part number

Optical drive cable 752339-001

Hard drive cable 752338-001

The hard drive and optical drive connectors are located near the middle of the computer. Each connector is 
secured with two Torx screws and has two cables that connect to the system board.

The optical drive connector cables are longer than the hard drive connector cables.

To remove the hard drive or optical drive connector:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 19).

2. Remove the rear cover (see Rear cover on page 20).

3. Remove the optical drive (see Replacing the optical disc drive on page 26).

4. Remove the hard drive (see Replacing drives on page 23).

5. Remove two Torx screws that secure the hard drive connector (1) or the optical drive connector (2) to 
the computer.

6. Disconnect the hard drive cables (1) or the optical drive cables (2) from the system board.

The hard drive cables connect to the SATA_PWR0 and SATA0 connectors on the system board. The 
optical drive cables connect to the SATA_PWR1 and SATA1 connectors on the system board.

NOTE: Be careful not to damage the cable when disconnecting it from the board. Do not pull on the 
wires.

7. If removing the optical drive connector, remove the cable from the clips built into the fan (3).
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8. Remove the connector from the computer.

To install the hard drive or optical drive connector, reverse the removal procedures.
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System board cover

To remove the system board cover:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 19).

2. Remove the rear cover (see Rear cover on page 20).

3. Remove the four Torx screws that secure the cover to the computer.
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4. Lift the cover straight up and off the computer.

To replace the lower panel, reverse the removal procedures.
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Memory

Description Spare part number

4-GB memory module (PC3-12800; SODOMM) 689373-001

2-GB memory module (PC3-12800; SODOMM) 689372-001

Memory modules are located on the right side of the computer (viewed from behind). The computer has two 
memory slots.

For proper system operation, the SODIMMs must be:

● industry-standard 204-pin

● unbuffered non-ECC PC3-12800 DDR3-1600 MHz-compliant

● 1.5 volt DDR3-SDRAM SODIMMs

The DDR3-SDRAM SODIMMs must also:

● support CAS latency 11 DDR3 1600 MHz (11-11-11 timing)

● contain the mandatory Joint Electronic Device Engineering Council (JEDEC) specification

In addition, the computer supports:

● 1-Gbit, 2-Gbit, and 4-Gbit non-ECC memory technologies

● single-sided and double-sided SODIMMS

● SODIMMs constructed with x8 and x16 SDRAMs; SODIMMs constructed with x4 SDRAMs are not 
supported

NOTE: The system will not operate properly if you install unsupported SODIMM memory.

The system will automatically operate in single channel mode, dual channel mode, or flex mode, depending 
on how the SODIMMs are installed. Refer to the following table to identify the SODIMM channel locations.

Location System Board Label Channel

Lower Socket SODIMM1 Channel A

Upper Socket SODIMM3 Channel B
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● The system will operate in single channel mode if the SODIMM sockets are populated in one channel 
only.

● The system will operate in flex mode if the memory capacity of the SODIMM in Channel A is not equal to 
the memory capacity of the SODIMM in Channel B. In flex mode, the channel populated with the least 
amount of memory describes the total amount of memory assigned to dual channel and the remainder 
is assigned to single channel. If one channel will have more memory than the other, the larger amount 
should be assigned to channel A.

● The system will operate in a higher-performing dual channel mode if the memory capacity of the 
SODIMM in Channel A is equal to the memory capacity of the SODIMM in Channel B.

● In any mode, the maximum operational speed is determined by the slowest SODIMM in the system.

There are two memory sockets on the system board located behind the memory access panel. To remove or 
install memory modules:

To remove a memory module:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 19).

2. Place the computer face down on a soft flat surface. HP recommends that you set down a blanket, towel, 
or other soft cloth to protect the screen surface from scratches or other damage.

3. Remove the rear cover (see Rear cover on page 20).

4. Remove the system board cover (see System board cover on page 39).

5. To remove a memory module, press outward on the two latches on each side of the SODIMM (1), then 
pull the SODIMM out of the socket (2).

The computer automatically recognizes the additional memory when you turn on the computer.
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WLAN module

Description Spare part number

WLAN module for use in HP 205 G1 and HP 18 models:  

Ralink RT5390R 802.11bgn Wi-Fi Adapter 701399-001

WLAN module for use in HP 205 G2 models:  

HP Broadcom BCM943142HM 802.11 b/g/n WLAN + BT4.0 Mini Wireless Card 753076-001

Ralink RT5390R 802.11bgn Wi-Fi Adapter for use only in Brazil 806249-201

WLAN antenna kit 806248-001

The WLAN module is located on the right side of the system board. The module is secured with one Phillips 
screw and has two connected antennas.

To remove the WLAN module:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 19).

2. Remove the rear cover (see Rear cover on page 20).

3. Remove the system board cover (see System board cover on page 39).

4. Disconnect the antenna cables from the module (1).

5. Remove the Phillips screw (2) that secures the module to the computer.
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6. Lift the module to a 45-degree angle, and then pull it away to remove it from the socket (3).

To install the WLAN module, reverse the removal procedures.

NOTE: WLAN modules are designed with a notch to prevent incorrect insertion.

RTC battery
The battery is located in the memory compartment. The battery that comes with the computer provides 
power to the real-time clock. When replacing the battery, use a battery equivalent to the battery originally 
installed in the computer. The computer comes with a 3-volt lithium coin cell battery.

WARNING! The computer contains an internal lithium manganese dioxide battery. There is a risk of fire and 
burns if the battery is not handled properly. To reduce the risk of personal injury:

Do not attempt to recharge the battery.

Do not expose to temperatures higher than 60° C (140º F).

Do not disassemble, crush, puncture, short external contacts, or dispose of in fire or water.

Replace the battery only with the HP spare designated for this product.

CAUTION: Before replacing the battery, it is important to back up the computer CMOS settings. When the 
battery is removed or replaced, the CMOS settings will be cleared.

Static electricity can damage the electronic components of the computer or optional equipment. Before 
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a 
grounded metal object.

NOTE: The lifetime of the lithium battery can be extended by plugging the computer into a live AC wall 
socket. The lithium battery is only used when the computer is NOT connected to AC power.

HP encourages customers to recycle used electronic hardware, HP original print cartridges, and rechargeable 
batteries. For more information about recycling programs, go to http://www.hp.com/recycle.

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 19).

2. Remove the rear cover (see Rear cover on page 20).
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3. Remove the system board cover (see System board cover on page 39).

The battery can now be seen to the left of the heat sink.

4. To release the battery from its holder, squeeze the metal clamp that extends above one edge of the 
battery. When the battery pops up, lift it out (1).

5. To insert the new battery, slide one edge of the replacement battery under the holder’s lip with the 
positive side up. Push the other edge down until the clamp snaps over the other edge of the battery (2).
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System board

Description Spare part number

System board for use in HP 205 G1 models:  

● AMD E1-2500 APU for use in models with Windows 7 or without the Windows operating system 751275-001

● AMD E1-2500 APU for use in models with Windows 8.1 Standard 751275-501

● AMD E1-2500 APU for use in models with Windows 8.1 Professional or Windows 10 751275-601

System board for use in HP 205 G2 models:  

● AMD E1-6010 APU for use in models with Windows 7 or without the Windows operating system 806244-001

● AMD E1-6010 APU for use in models with Windows 8.1 Standard 806244-501

● AMD E1-6010 APU for use in models with Windows 8.1 Professional or Windows 10 806244-601

System board for use in HP 18 models:  

● Intel Pentium J2900 processor for use in models with Windows 7 or without the Windows operating 
system

782107-001

● Intel Pentium J2900 processor for use in models with Windows 8.1 Standard 782107-501

● Intel Pentium J2900 processor for use in models with Windows 8.1 Professional or Windows 10 782107-601

● Intel Celeron J1800 processor for use in models with Windows 7 or without the Windows operating 
system

782108-001

● Intel Celeron J1800 processor for use in models with Windows 8.1 Standard 782108-501

● Intel Celeron J1800 processor for use in models with Windows 8.1 Professional or Windows 10 782108-601

The system board is located on the right side of the computer (viewed from the rear). It is secured with eight 
Torx screws.

To remove the system board:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 19).

2. Remove the rear cover (see Rear cover on page 20).

3. Remove the system board cover (see System board cover on page 39).

4. Remove the memory modules (see Memory on page 41).

5. Remove the WLAN module (see WLAN module on page 43).

6. Disconnect all cables from the system board, noting their location for reinstallation.
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7. Remove the five Torx screws that secure the system board to the computer.

8. Remove the system board.

To install the system board, reverse the removal procedures.

Updating SMBIOS Information

When replacing the system board, you must reprogram the SMBIOS information on the affected computer. 
Failure to reprogram the board will result in eventual failure, such as an activation failure (need to reactivate 
the system) or a system recovery failure.

To update SMBIOS information in Computer Setup:

1. Turn on or restart the computer.

2. Press Esc while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the 
screen.

NOTE: If you do not press Esc at the appropriate time, you must restart the computer and again press 
Esc when the light turns white to access the utility.

3. Press F10 to enter Computer Setup.

4. Go to Security > System ID’s.

5. If necessary, press Ctrl+A to initiate edit mode.

6. Edit the fields listed. If the feature byte has data or is not editable, then it was not cleared and cannot be 
edited.

System ID Setup Page

Setup Field Name Comment Label

Product Name Enter the Model name/number or marketing name. Flexbuild
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Serial Number Enter the Serial Number of Unit. Support

SKU Number Enter the SKU or Product Number including Localization Code. Support

Asset Tag Enter the 18-byte identifier assigned to the computer. Support

Feature Byte Enter the Feature Byte string. The feature byte string is case sensitive.

The label includes spaces after every four characters. You can enter or ignore these 
spaces – their only purpose is to help with data entry. There is a character 
limitation of 40 bytes per line. When you reach this limit, go to the next line to 
continue data entry. BIOS ignores the spaces and lines.

If you make an error during data entry, the data will not validate, and the computer 
asks you to correct your data input.

Flexbuild

Build ID The Build ID of the unit. Flexbuild

Display panel

Description Spare part number

Display panel, 18.5-inch, anti-glare , LED N-ZBD, 200 nits 752345-001

Display panels require a backlight cable specific to the manufacturer. Make sure you use the backlight cable 
packaged with the display panel.

The display panel is secured to the computer with four Torx screws.

To remove the display panel:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 19).

2. Remove the rear cover (see Rear cover on page 20).

3. Remove the optical drive (see Replacing the optical disc drive on page 26).

4. Remove the system board cover (see System board cover on page 39).

5. Remove the memory modules (see Memory on page 41).

6. Remove the WLAN module (see WLAN module on page 43).

7. Remove the speakers (see Speakers on page 34).

8. Remove the hard drive (see Replacing drives on page 23).

9. Remove the front bezel (see Front bezel on page 28).
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10. Disconnect the backlight cable from the display panel.

NOTE: Replace the backlight cable with the new backlight cable that comes with the new display panel 
kit.

Remove the backlight cable from the defective panel before sending the panel back to the supplier.

11. Remove the four Torx screws (two on each side) that secure the display panel to the frame.

12. Lift the display panel from the frame.

To install a display panel, reverse the removal procedures.
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6 Computer Setup (F10) Utility

Computer Setup (F10) Utilities
Use Computer Setup (F10) Utility to do the following:

● Change factory default settings.

● Set the system date and time.

● Set, view, change, or verify the system configuration, including settings for processor, graphics, 
memory, audio, storage, communications, and input devices.

● Modify the boot order of bootable devices such as hard drives, optical drives, or USB flash media devices.

● Enable Quick Boot, which is faster than Full Boot but does not run all of the diagnostic tests run during a 
Full Boot. You can set the system to:

■ always Quick Boot (default);

■ periodically Full Boot (from every 1 to 30 days); or

■ always Full Boot.

● Select Post Messages Enabled or Disabled to change the display status of Power-On Self-Test (POST) 
messages. Post Messages Disabled suppresses most POST messages, such as memory count, product 
name, and other non-error text messages. If a POST error occurs, the error is displayed regardless of the 
mode selected. To manually switch to Post Messages Enabled during POST, press any key (except F1 
through F12).

● Establish an Ownership Tag, the text of which is displayed each time the system is turned on or 
restarted.

● Enter the Asset Tag or property identification number assigned by the company to this computer.

● Enable the power-on password prompt during system restarts (warm boots) as well as during power-on.

● Establish a setup password that controls access to the Computer Setup (F10) Utility and the settings 
described in this section.

● Secure integrated I/O functionality, including the serial, USB, or parallel ports, audio, or embedded NIC, 
so that they cannot be used until they are unsecured.

● Enable or disable removable media boot ability.

● Solve system configuration errors detected but not automatically fixed during the Power-On Self-Test 
(POST).

● Replicate the system setup by saving system configuration information on a USB device and restoring it 
on one or more computers.

● Execute self-tests on a specified ATA hard drive (when supported by drive).

● Enable or disable DriveLock security (when supported by drive).
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Using Computer Setup (F10) Utilities

Computer Setup can be accessed only by turning the computer on or restarting the system. To access the 
Computer Setup Utilities menu, complete the following steps:

1. Turn on or restart the computer.

2. Repeatedly press F10 when the power light turns white to access the utility.

You can also press Esc to a menu that allows you to access different options available at startup, 
including the Computer Setup utility.

NOTE: If you do not press F10 at the appropriate time, you must restart the computer and again 
repeatedly press F10 when the power light turns white to access the utility.

3. A choice of five headings appears in the Computer Setup Utilities menu: File, Storage, Security, Power, 
and Advanced.

4. Use the arrow (left and right) keys to select the appropriate heading. Use the arrow (up and down) keys 
to select the option you want, then press Enter. To return to the Computer Setup Utilities menu, press 
Esc.

5. To apply and save changes, select File > Save Changes and Exit.

● If you have made changes that you do not want applied, select Ignore Changes and Exit.

● To reset to factory settings or previously saved default settings (some models), select Apply 
Defaults and Exit. This option will restore the original factory system defaults.

NOTE: Not all settings shown in the following sections are available for all models

CAUTION: Do NOT turn the computer power OFF while the BIOS is saving the Computer Setup (F10) changes 
because the CMOS could become corrupted. It is safe to turn off the computer only after exiting the F10 Setup 
screen.

Table 6-1  Computer Setup (F10) Utility

Heading Table

File Computer Setup—File on page 52

Storage Computer Setup—Storage on page 53

Security Computer Setup—Security on page 54

Power Computer Setup—Power on page 58

Advanced Computer Setup—Advanced on page 59
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Computer Setup—File

NOTE: Support for specific Computer Setup options may vary depending on the hardware configuration.

Table 6-2  Computer Setup—File

Option Description

System Information Lists:

● Product name

● SKU number

● Processor type/speed/stepping

● Cache size (L1/L2/L3) (dual core processors have this listed twice)

● Installed memory size/speed, number of channels (single or dual) (if applicable)

● Integrated MAC address for embedded, enabled NIC (if applicable)

● System BIOS (includes family name and version)

● Chassis serial number

● Asset tracking number

● ME firmware version

● ME Management mode

About Displays copyright notice.

Set Time and Date Allows you to set system time and date.

Flash System ROM Allows you to update the system ROM with a BIOS image file located on removable media.

Replicated Setup Save to Removable Media

Saves system configuration to a formatted USB flash media device.

Restore from Removable Media

Restores system configuration from a USB flash media device.

Default Setup Save Current Settings as Default

Saves the current system configuration settings as the default.

Restore Factory Settings as Default

Restores the factory system configuration settings as the default.

Apply Defaults and Exit Applies the currently selected default settings and clears any established passwords.

Ignore Changes and Exit Exits Computer Setup without applying or saving any changes.

Save Changes and Exit Saves changes to system configuration or default settings and exits Computer Setup.
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Computer Setup—Storage

NOTE: Support for specific Computer Setup options may vary depending on the hardware configuration.

Table 6-3  Computer Setup—Storage

Option Description

Device Configuration Lists all installed BIOS-controlled storage devices.

When a device is selected, detailed information and options are displayed. The following options may be 
presented:

● Hard Disk: Size, model, firmware version, serial number, connector color.

● CD-ROM: Model, firmware version, serial number, connector color (not included for USB CD-ROM).

● SMART (ATA disks only)

● Diskette: Model and firmware version.

NOTE: Displays for USB diskette drives.

Storage Options SATA Emulation

Allows you to choose how the SATA controller and devices are accessed by the operating system. There 
are three supported options: IDE, RAID, and AHCI (default).

CAUTION: SATA emulation changes may prevent access to existing hard drive data and degrade or 
corrupt established volumes.

IDE - This is the most backwards-compatible setting of the three options. Operating systems usually do 
not require additional driver support in IDE mode.

RAID - Allows DOS and boot access to RAID volumes. Use this mode with the RAID device driver loaded in 
the operating system to take advantage of RAID features.

AHCI (default option) - Allows operating systems with AHCI device drivers loaded to take advantage of 
more advanced features of the SATA controller.

NOTE: The RAID/AHCI device driver must be installed prior to attempting to boot from a RAID/AHCI 
volume. If you attempt to boot from a RAID/AHCI volume without the required device driver installed, the 
system will crash (blue screen). RAID volumes may become corrupted if they are booted to after disabling 
RAID.

Removable Media Boot

Enables/disables ability to boot the system from removable media. Default is enabled.

Boot Order Allows you to:

● EFI Boot Sources: Specify the order in which EFI boot sources (such as a internal hard drive, USB 
hard drive, USB optical drive, or internal optical drive) are checked for a bootable operating system 
image. Each device on the list may be individually excluded from or included for consideration as a 
bootable operating system source.

EFI boot sources always have precedence over legacy boot sources.

● Legacy Boot Sources: Specify the order in which legacy boot sources (such as a network interface 
card, internal hard drive, USB optical drive, or internal optical drive) are checked for a bootable 
operating system image. Each device on the list may be individually excluded from or included for 
consideration as a bootable operating system source.

Specify the order of attached hard drives. The first hard drive in the order will have priority in the 
boot sequence and will be recognized as drive C (if any devices are attached).

NOTE: To drag a device to a preferred place, press Enter. To remove the device from consideration as a 
bootable device, press F5.

You can use F5 to disable individual boot items, as well as disable EFI boot and/or legacy boot.
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Table 6-3  Computer Setup—Storage (continued)

NOTE: MS-DOS drive lettering assignments may not apply after a non-MS-DOS operating system has 
started.

Shortcut to Temporarily Override Boot Order

To boot one time from a device other than the default device specified in Boot Order, restart the computer 
and press Esc (to access the boot menu) and then F9 (Boot Order), or only F9 (skipping the boot menu) 
when the powr light turns white. After POST is completed, a list of bootable devices is displayed. Use the 
arrow keys to select the preferred bootable device and press Enter. The computer then boots from the 
selected non-default device for this one time.

Computer Setup—Security

NOTE: Support for specific Computer Setup options may vary depending on the hardware configuration.

Table 6-4  Computer Setup—Security

Option Description

Setup Password Allows you to set and enable a setup (administrator) password.

NOTE: If the setup password is set, it is required to change Computer Setup options, flash the ROM, and 
make changes to certain plug and play settings under Windows.

Power-On Password Allows you to set and enable a power-on password. The power-on password prompt appears after a 
power cycle or reboot. If the user does not enter the correct power-on password, the unit will not boot.

Password Options

(This selection appears 
only if a power-on 
password or setup 
password is set.)

Allows you to enable/disable:

● Lock Legacy Resources (determines whether or not Windows Device Manager is allowed to change 
resource settings for serial and parallel ports).

● Stringent security (enabling the stringent password disables the ability to reset the password by 
moving the jumper on the system board). Default is disabled.

CAUTION: If you enable the stringent security feature and you forget the setup password or the 
power-on password, the computer is inaccessible and can no longer be used.

If you lose or forget the password, the system board must be replaced. This scenario is not covered 
under warranty.

To prevent the computer from becoming permanently unusable, record your configured setup 
password or power-on password in a safe place away from your computer. Without these 
passwords, the computer cannot be unlocked.

● Setup Browse Mode (appears if a setup password is set) (allows viewing, but not changing, the F10 
Setup Options without entering setup password). Default is enabled.

● Password prompt on F9 & F12 (requires setup password to use these boot functions). Default is 
enabled.

● Network Server Mode. Default is disabled.

Smart Cover Allows you to:

● Lock/unlock the Cover Lock.

● Set the Cover Removal Sensor to Disable/Notify User/Setup Password.

NOTE: Notify User alerts the user that the sensor has detected that the cover has been removed. Setup 
Password requires that the setup password be entered to boot the computer if the sensor detects that the 
cover has been removed.

Device Security Allows you to set Device Available/Device Hidden (default is Device Available) for:

● Embedded security device
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Table 6-4  Computer Setup—Security (continued)

● System audio

● USB controller (varies by model)

● Network controller

NOTE: You must disable AMT before trying to hide the network controller.

● Serial port

● Parallel port

● SATA ports (varies by model)

USB Security Allows you to set Enabled/Disabled (default is Enabled) for:

● Front USB Ports

● Rear USB Ports

● Accessory USB Ports

Slot Security Allows you to disable any PCI or PCI Express slot. Default is enabled.

Network Boot Enables/disables the computer’s ability to boot from an operating system installed on a network server. 
Default is enabled.

System IDs Allows you to set:

● Asset tag (18-byte identifier), a property identification number assigned by the company to the 
computer.

● Ownership tag (80-byte identifier) displayed during POST.

● Universal Unique Identifier (UUID) number. The UUID can only be updated if the current chassis serial 
number is invalid. (These ID numbers are normally set in the factory and are used to uniquely 
identify the system.)

● Keyboard locale setting for System ID entry.

Master Boot Record 
Security

Enables/disables Master Boot Record (MBR) security.

The MBR contains information needed to successfully boot from a disk and to access the data stored on 
the disk. Master Boot Record Security may prevent unintentional or malicious changes to the MBR, such as 
those caused by some viruses or by the incorrect use of certain disk utilities. It also allows you to recover 
the "last known good" MBR, should changes to the MBR be detected when the system is restarted.

When MBR Security is enabled, the BIOS prevents any changes being made to the MBR of the current 
bootable disk while in MS-DOS or Windows Safe Mode.

NOTE: Most operating systems control access to the MBR of the current bootable disk; the BIOS cannot 
prevent changes that may occur while the operating system is running. 

Restores the backup Master Boot Record to the current bootable disk. Default is disabled.

Only appears if all of the following conditions are true:

● MBR security is enabled

● A backup copy of the MBR has been previously saved

● The current bootable disk is the same disk from which the backup copy was saved

CAUTION: Restoring a previously saved MBR after a disk utility or operating system has modified the 
MBR, may cause the data on the disk to become inaccessible. Only restore a previously saved MBR if you 
are confident that the current bootable disk's MBR has been corrupted or infected with a virus.

System Security (these 
options are hardware 
dependent)

Data Execution Prevention (enable/disable) - Helps prevent operating system security breaches. Default is 
enabled.
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Table 6-4  Computer Setup—Security (continued)

SVM CPU Virtualization (enable/disable). Controls the virtualization features of the processor. Changing 
this setting requires turning the computer off and then back on. Default is disabled.

Virtualization Technology (VTx) (enable/disable) - Controls the virtualization features of the processor. 
Changing this setting requires turning the computer off and then back on. Default is disabled.

Virtualization Technology Directed I/O (VTd) (enable/disable) - Controls virtualization DMA remapping 
features of the chipset. Changing this setting requires turning the computer off and then back on. Default 
is disabled.

Trusted Execution Technology (enable/disable) - Controls the underlying processor and chipset features 
needed to support a virtual appliance. Changing this setting requires turning the computer off and then 
back on. Default is disabled. To enable this feature you must enable the following features:

● Embedded Security Device Support

● Virtualization Technology

● Virtualization Technology Directed I/O

Embedded Security Device (enable/disable) - Permits activation and deactivation of the Embedded 
Security Device.

NOTE: To configure the Embedded Security Device, a Setup password must be set.

● Reset to Factory Settings (Do not reset/Reset) - Resetting to factory defaults will erase all security 
keys and leave the device in a disabled state. Changing this setting requires that you restart the 
computer. Default is Do not reset.

CAUTION: The embedded security device is a critical component of many security schemes. 
Erasing the security keys will prevent access to data protected by the Embedded Security Device. 
Choosing Reset to Factory Settings may result in significant data loss.

● Measure boot variables/devices to PCR1 - Typically, the computer measures the boot path and saves 
collected metrics to PCR5 (a register in the Embedded Security Device). Bitlocker tracks changes to 
any of these metrics, and forces the user to re-authenticate if it detects any changes. Enabling this 
feature lets you set Bitlocker to ignore detected changes to boot path metrics, thereby avoiding re-
authentication issues associated with USB keys inserted in a port. Default is enabled.

System Security 
(continued)

OS management of Embedded Security Device (enable/disable) - This option allows the user to limit OS 
control of the Embedded Security Device. Default is enabled. This option is automatically disabled if 
Trusted Execution Technology is enabled.

● Reset of Embedded Security Device through OS (enable/disable) - This option allows the user to limit 
the operating system ability to request a Reset to Factory Settings of the Embedded Security Device. 
Default is disabled.

NOTE: To enable this option, a Setup password must be set.

● No PPI provisioning (Windows 8.1 only) - This option lets you set Windows 8.1 to bypass the PPI 
(Physical Presence Interface) requirement and directly enable and take ownership of the TPM on first 
boot. You cannot change this setting after TPM is owned/initialized, unless the TPM is reset. Default 
is disabled for non-Windows 8.1 systems, and enabled for Windows 8.1.

● Allow PPI policy to be changed by OS. Enabling this option allows the operating system to execute 
TPM operations without Physical Presence Interface. Default is disabled.

NOTE: To enable this option, a Setup password must be set.

DriveLock Security Allows you to assign or modify a master or user password for hard drives. When this feature is enabled, 
the user is prompted to provide one of the DriveLock passwords during POST. If neither is successfully 
entered, the hard drive will remain inaccessible until one of the passwords is successfully provided during 
a subsequent cold-boot sequence.

NOTE: This selection will only appear when at least one drive that supports the DriveLock feature is 
attached to the system.

Secure Boot 
Configuration

This is a feature of Windows 8.1.
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Table 6-4  Computer Setup—Security (continued)

● Legacy Support—Enable/Disable. Allows you to turn off all legacy support on the computer, 
including booting to DOS, booting to legacy devices, and so on. If set to disable, legacy boot options 
in Storage > Boot Order are not displayed. Default is enabled.

● Secure Boot—Enable/Disable. Allows you to make sure an operating system is legitimate before 
booting to it, making Windows resistant to malicious modification from preboot to full OS booting, 
preventing firmware attacks. UEFI and Windows Secure Boot only allow code signed by pre-
approved digital certificates to run during the firmware and OS boot process. Default is disabled, 
except for Windows 8.1 systems which have this setting enabled. Secure Boot enabled also sets 
Legacy Support to disabled.

● Key Management—This option lets you manage the custom key settings.

◦ Clear Secure Boot Keys—Don't Clear/Clear. Allows you to delete any previously loaded custom 
boot keys. Default is Don't Clear.

◦ Key Ownership—HP Keys/Custom Keys. Selecting Custom Mode allows you to modify the 
contents of the secure boot signature databases and the platform key (PK) that verifies kernels 
during system start up, allowing you to use alternative operating systems. Selecting HP Keys 
causes the computer boot using the preloaded HP-specific boot keys. Default is HP Keys.

● Fast Boot—Enable/Disable. Fast boot disables the ability to interrupt boot, such as pressing f keys 
to access items before the operating system loads. Default is disabled.

NOTE: If Windows 8.1 detects a serious error, it will interrupt the boot process automatically and 
display advanced boot options.

From Windows 8.1, you can press Shift and select Restart to access the screen that lets you boot to 
a device or troubleshoot your computer.
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Computer Setup—Power

NOTE: Support for specific Computer Setup options may vary depending on the hardware configuration.

Table 6-5  Computer Setup—Power

Option Description

OS Power Management ● Idle Power Savings—Extended/Normal. Allows certain operating systems to decrease the 
processors power consumption when the processor is idle. Default is extended.

● Runtime Power Management— Enable/Disable. Allows certain operating systems to reduce 
processor voltage and frequency when the current software load does not require the full 
capabilities of the processor. Default is enabled.

● Unique Sleep State Blink Rates—Enable/Disable. This feature is designed to provide a visual 
indication of what sleep state the system is in. Each sleep state has a unique blink pattern. Default is 
disabled.

NOTE: For Windows 8.1 systems with Fast Boot support, a normal shutdown goes to the S4 state, 
not the S5 state.

◦ S0 (On) = Solid white LED.

◦ S3 (Stand By)= 3 blinks at 1Hz (50% duty cycle) followed by a pause of 2 seconds (white LED) 
— repeated cycles of 3 blinks and a pause.

◦ S4 (Hibernation)= 4 blinks at 1Hz (50% duty cycle) followed by a pause of 2 seconds (white 
LED) — repeated cycles of 4 blinks and a pause.

◦ S5 (Soft Off) = LED is off.

Hardware Power 
Management

SATA Power Management – Enables or disables SATA bus and/or device power management. Default is 
enabled.

S5 Maximum Power Savings – Turns off power to all nonessential hardware when system is off to meet 
EUP Lot 6 requirement of less than 0.5 Watt power usage. Default is disabled.

PCI Express x16 Slot 1 – Sets Active State Power Management (ASPM) of the bus. ASPM lets you set lower 
power modes that activate when the bus is not being used. Options are Disabled, LOs, L1, LOs and L1. 
Default is ASPM Disabled.

PCI Express x1 Slot 1 – Sets Active State Power Management (ASPM) of the bus. ASPM lets you set lower 
power modes that activate when the bus is not being used. Options are Disabled, LOs, L1, LOs and L1. 
Default is ASPM Disabled.

Network Controller – Sets ASPM of the bus. ASPM lets you set lower power modes that activate when the 
bus is not being used. Options are Disabled, LOs, L1, LOs and L1. Default is ASPM Disabled.

USB 3.0 Controller – Sets ASPM of the bus. ASPM lets you set lower power modes that activate when the 
bus is not being used. Options are Disabled, LOs, L1, LOs and L1. Default is ASPM Disabled.

Thermal Fan idle mode—This bar graph controls the minimum permitted fan speed.

NOTE: This setting only changes the minimum fan speed. The fans are still automatically controlled.
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Computer Setup—Advanced

NOTE: Support for specific Computer Setup options may vary depending on the hardware configuration.

Table 6-6  Computer Setup—Advanced (for advanced users)

Option Heading

Power-On Options Allows you to set:

● POST mode (QuickBoot, Clear Memory, FullBoot, or FullBoot Every x Days).

◦ QuickBoot (default) = Do not clear memory or perform a memory test.

◦ FullBoot = Memory test (count) on cold boot. Clears memory on all boots.

◦ Clear Memory = No memory count on cold boot. Clears memory on all boots.

◦ FullBoot Every x Days = Memory count on 1st cold boot on or after the xth day. No more 
memory counts until 1st cold boot on or after x days. Clears memory on all boots.

● POST messages (enable/disable). Enabling this feature will cause the system to display POST error 
messages, which are error messages displayed during the Power On Self Test if the BIOS encounters 
some kind of problem while starting the PC. A POST error message will only display on screen if the 
computer is capable of booting this far. If the POST detects an error before this point, a beep code is 
generated instead. Default is disabled.

● Press the ESC key for Startup Menu (Enable/Disable). This feature controls the display of the text 
“Press the ESC key for Startup Menu” during POST. This text does not display on Windows 8.1 
systems with Fast Boot support. Other text also will not display (for example, Ownership Tag). 
Default is enabled.

● Option ROM Prompt (enable/disable). Enabling this feature will cause the system to display a 
message before loading option ROMs. Default is enabled.

● After Power Loss (off/on/previous state). Default is Power off. Setting this option to:

◦ Power off—causes the computer to remain powered off when power is restored.

◦ Power on—causes the computer to power on automatically as soon as power is restored.

◦ Previous state—causes the computer to power on automatically as soon as power is restored, 
if it was on when power was lost.

NOTE: If you turn off power to the computer using the switch on a power strip, you will not be able to 
use the suspend/sleep feature or the Remote Management features.

● POST Delay (in seconds). Enabling this feature will add a user-specified delay to the POST process. 
This delay is sometimes needed for hard disks on some PCI cards that spin up very slowly, so slowly 
that they are not ready to boot by the time POST is finished. The POST delay also gives you more 
time to select F10 to enter Computer (F10) Setup. Default is None.

● Remote Wakeup Boot Source (remote server/local hard drive). Default is Local hard drive.

● Factory Recovery Boot Support (Enable/Disable). Provides the ability for the BIOS to redirect the 
boot to the recovery partition on the user hard drive, if present. Some versions of the recovery 
software honor the F11 key press even when this feature is disabled by the BIOS. Default is disabled.

● Bypass F1 Prompt on Configuration Changes (Enable/Disable). Allows you to set the computer not to 
confirm when changes were made. Default is disabled.

BIOS Power-On Allows you to set the computer to turn on automatically at a time you specify.

Onboard Devices Allows you to set resources for or disable Legacy devices.

Select the Legacy device's IRQ, DMA, and I/O Range. The settings may not take effect for all operating 
systems. To hide a device from the operating system, see Security > Device Security.

Bus Options Allows you to enable or disable:

● PCI SERR# Generation. Default is enabled.
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Table 6-6  Computer Setup—Advanced (for advanced users) (continued)

● PCI VGA Palette Snooping is not used. Default is disabled.

Device Options Allows you to set:

● Printer mode (Bi-Directional, EPP + ECP, Output Only). ECP = Enhanced Capabilities Port, EPP = 
Enhanced Parallel Port. Default is EPP+ECP.

● Num Lock State at Power-On (off/on). Default is off.

● Integrated Video (enable/disable). Use this option to disable the integrated video controller when 
another video controller is present in the system. Default is enabled.

● Integrated Graphics (Auto/Disable/Force) Use this option to manage integrated (UMA) graphics 
memory allocation. The value you choose is allocated permanently to graphics and is unavailable to 
the operating system. For example, if you set this value to 512M on a system with 2 GB of RAM, the 
system always allocates 512 MB for graphics and the other 1.5 GB for use by the BIOS and operating 
system. Default is Auto which sets memory allocation to 512 MB.

If you select Force, the UMA Frame Buffer Size option displays, which lets you set the UMA memory 
size allocation between 32 MB and 1 GB.

● Internal Speaker (does not affect external speakers). Default is enabled.

● NIC PXE Option ROM Download (PXE, iSCSI, disabled). The BIOS contains an embedded NIC option 
ROM to allow the unit to boot through the network to a PXE server. This is typically used to download 
a corporate image to a hard drive. The NIC option ROM takes up memory space below 1MB 
commonly referred to as DOS Compatibility Hole (DCH) space. This space is limited. This F10 option 
will allow users to disable the downloading of this embedded NIC option ROM thus giving more DCH 
space for additional PCI cards which may need option ROM space. The default will be to have the NIC 
option-ROM-enabled. Default is PXE.

● SATA RAID Option ROM Download (enable/disable). The BIOS contains an embedded SATA RAID 
option ROM for RAID support. This can be temporarily disabled to save DCH space. Note that with the 
option ROM disabled, users will be unable to boot to hard drives in the system while running in RAID 
mode. Default is disabled.

● Multi-Processor (enable/disable). Use this option to disable multi-processor support under the OS. 
Default is enabled.

● Hyper threading (enable/disable). Use this option to disable processor hyper-threading.

● Turbo Mode (enable/disable). Allows you to enable and disable the Intel Turbo Mode feature, which 
allows one core of the system to run at a higher than standard frequency and power if other cores 
are idle. Default is enabled.

VGA Configuration Displayed only if there is an add-in video card in the system. Allows you to specify which VGA controller 
will be the “boot” or primary VGA controller.

AMT Configuration Allows you to set:

● AMT (enable/disable). Allows you to enable or disable functions of the embedded Management 
Engine (ME) such as Active Management Technology (AMT). If set to disable, the Management Engine 
is set to a temporarily disabled state and will not provide functions beyond necessary system 
configuration. Default is enabled.

● Unconfigure AMT/ME (enable/disable). Allows you to unconfigure any provisioned management 
settings for AMT. The AMT settings are restored to factory defaults. This feature should be used with 
caution as AMT will not be able to provide any set AMT management functions once unconfigured. 
Default is disabled.

● Hide Unconfigure ME Confirmation Prompt (enable/disable). Allows you to set the system to not 
display the confirmation to unconfigure ME.

● Watchdog Timer (enable/disable). Allows you to set amount of time for a operating system and BIOS 
watchdog alert to be sent if the timers are not deactivated. BIOS watchdog is deactivated by BIOS 
and would indicate that a halt occurred during execution if the alert is sent to the management 
console. An operating system alert is deactivated by the operating system image and would indicate 
that a hang occurred during its initialization. Default is enabled.
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Recovering the Configuration Settings
This method of recovery requires that you first perform the Save to Removable Media command with the 
Computer Setup (F10) Utility before Restore is needed. (See Computer Setup—File on page 52 in the 
Computer Setup—File table.)

NOTE: It is recommended that you save any modified computer configuration settings to a USB flash media 
device and save the device for possible future use.

To restore the configuration, insert the USB flash media device with the saved configuration and perform the 
Restore from Removable Media command with the Computer Setup (F10) Utility. (See Computer Setup—File 
on page 52 in the Computer Setup—File table.)
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7 Troubleshooting without diagnostics

This chapter provides information on how to identify and correct minor problems, such as USB devices, hard 
drive, optical drive, graphics, audio, memory, and software problems. If you encounter problems with the 
computer, refer to the tables in this chapter for probable causes and recommended solutions.

NOTE: For information on specific error messages that may appear on the screen during Power-On Self-Test 
(POST) at startup, see POST Numeric Codes and Text Messages on page 103.

Safety and comfort
WARNING! Misuse of the computer or failure to establish a safe and comfortable work environment may 
result in discomfort or serious injury. Refer to the Safety & Comfort Guide at http://www.hp.com/ergo for 
more information on choosing a workspace and creating a safe and comfortable work environment. For more 
information, refer to the Safety & Regulatory Information guide.

Before you call for technical support
If you are having problems with the computer, try the appropriate solutions below to try to isolate the exact 
problem before calling for technical support.

● Run the HP diagnostic tool.

● Run the hard drive self-test in Computer Setup. Refer to Computer Setup (F10) Utility on page 50 for 
more information.

● Check the Power LED on the front of the computer to see if it is flashing red. The flashing lights are error 
codes that will help you diagnose the problem. Refer to Interpreting POST diagnostic front panel LEDs 
on page 109 for more information.

● If the screen is blank, plug the monitor into a different video port on the computer if one is available. Or, 
replace the monitor with a monitor that you know is functioning properly.

● If you are working on a network, plug another computer with a different cable into the network 
connection. There may be a problem with the network plug or cable.

● If you recently added new hardware, remove the hardware and see if the computer functions properly.

● If you recently installed new software, uninstall the software and see if the computer functions properly.

● Boot the computer to the Safe Mode to see if it will boot without all of the drivers loaded. When booting 
the operating system, use “Last Known Configuration.”

● Refer to the comprehensive online technical support at http://www.hp.com/support.

● Refer to Helpful hints on page 63 in this guide.

To assist you in resolving problems online, HP Instant Support Professional Edition provides you with self-
solve diagnostics. If you need to contact HP support, use HP Instant Support Professional Edition's online chat 
feature. Access HP Instant Support Professional Edition at: http://www.hp.com/go/ispe.

Access the Business Support Center (BSC) at http://www.hp.com/go/bizsupport for the latest online support 
information, software and drivers, proactive notification, and worldwide community of peers and HP experts.
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If it becomes necessary to call for technical assistance, be prepared to do the following to ensure that your 
service call is handled properly:

● Be in front of your computer when you call.

● Write down the computer serial number, product ID number, and monitor serial number before calling.

● Spend time troubleshooting the problem with the service technician.

● Remove any hardware that was recently added to your system.

● Remove any software that was recently installed.

● Restore the system from the Recovery Disc Set that you created or restore the system to its original 
factory condition in System Software Requirement Disks (SSRD).

CAUTION: Restoring the system will erase all data on the hard drive. Be sure to back up all data files before 
running the restore process.

NOTE: For sales information and warranty upgrades (Care Packs), call your local authorized service provider 
or dealer.

Helpful hints
If you encounter problems with the computer, monitor, or software, see the following list of general 
suggestions before taking further action:

● Check that the computer and monitor are plugged into a working electrical outlet.

● Check that the voltage select switch (some models) is set to the appropriate voltage for your region 
(115V or 230V).

● Check that the computer is turned on and the white power light is on.

● Check that the monitor is turned on and the green monitor light is on.

● Check the Power LED on the front of the computer to see if it is flashing red. The flashing lights are error 
codes that will help you diagnose the problem. Refer to Interpreting POST diagnostic front panel LEDs 
on page 109 for more information.

● Turn up the brightness and contrast controls of the monitor if the monitor is dim.

● Press and hold any key. If the system beeps, then the keyboard should be operating correctly.

● Check all cable connections for loose connections or incorrect connections.

● Wake the computer by pressing any key on the keyboard or pressing the power button. If the system 
remains in suspend mode, shut down the computer by pressing and holding the power button for at 
least four seconds then press the power button again to restart the computer. If the system will not shut 
down, unplug the power cord, wait a few seconds, then plug it in again. The computer will restart if it is 
set to power on automatically as soon as power is restored in Computer Setup. If it does not restart, 
press the power button to start the computer.

● Reconfigure the computer after installing a non-plug and play expansion board or other option. See 
Solving Hardware Installation Problems on page 82 for instructions.

● Be sure that all the needed device drivers have been installed. For example, if you are using a printer, 
you need a driver for that model printer.

● Remove all bootable media (CD/DVD or USB device) from the system before turning it on.
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● If you have installed an operating system other than the factory-installed operating system, check to be 
sure that it is supported on the system.

● If the system has multiple video sources (embedded, PCI, or PCI-Express adapters) installed (embedded 
video on some models only) and a single monitor, the monitor must be plugged into the monitor 
connector on the source selected as the primary VGA adapter. During boot, the other monitor connectors 
are disabled and if the monitor is connected into these ports, the monitor will not function. You can 
select which source will be the default VGA source in Computer Setup.

CAUTION: When the computer is plugged into an AC power source, there is always voltage applied to the 
system board. You must disconnect the power cord from the power source before opening the computer to 
prevent system board or component damage.

Solving general problems
You may be able to easily resolve the general problems described in this section. If a problem persists and you 
are unable to resolve it yourself or if you feel uncomfortable about performing the operation, contact an 
authorized dealer or reseller.

WARNING! When the computer is plugged into an AC power source, voltage is always applied to the system 
board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be sure to disconnect 
the power cord from the wall outlet and allow the internal system components to cool before touching.

Cannot access the Computer Setup (F10) Utility when booting the computer.

Cause Solution

The Computer Setup (F10) Utility is set to “fast boot” causing the 
F10 access screen to display too briefly when booting the 
computer.

Before turning on the computer, press and hold F10. Turn on the 
computer and continue to hold F10 until the Computer Setup 
(F10) Utility is displayed.

- or –

Follow the Windows instructions for rebooting the computer into 
the Computer Setup (F10) Utility.

Computer appears locked up and will not turn off when the power button is pressed.

Cause Solution

Software control of the power switch is not functional. 1. Press and hold the power button for at least four seconds 
until the computer turns off.

2. Disconnect the power cord from the electrical outlet.

Computer will not respond to keyboard or mouse.

Cause Solution

Computer is in Sleep state. To resume from Sleep state, press the power button.

CAUTION: When attempting to resume from Sleep state, do not 
hold down the power button for more than four seconds. 
Otherwise, the computer will shut down and you will lose any 
unsaved data.

System has locked up. Restart computer.
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Computer date and time display is incorrect.

Cause Solution

RTC (real-time clock) battery may need to be replaced.

NOTE: Connecting the computer to a live AC outlet prolongs the 
life of the RTC battery.

Reset the date and time under Control Panel (Computer Setup 
can also be used to update the RTC date and time). If the problem 
persists, replace the RTC battery. See the Removal and 
Replacement section for instructions on installing a new battery, 
or contact an authorized dealer or reseller for RTC battery 
replacement.

To access Control Panel in Windows 7, select Start, and then 
select Control Panel.

To access Control Panel in Windows 8.1, from the Start screen, 
type c, and then select Control Panel from the list of 
applications.

To access Control Panel in Windows 10, type control panel in 
the taskbar search box, and then select Control Panel.

Cursor will not move using the arrow keys on the keypad.

Cause Solution

The Num Lock key is turned on. Press the Num Lock key. The Num Lock light must be off if you 
want to use the arrow keys on the keypad. You can also disable or 
enable the Num Lock key in Computer Setup at Advanced > 
Device Options.

There is no sound or sound volume is too low.

Cause Solution

System volume may be set low or muted. 1. Check the Computer Setup settings to make sure the 
internal system speaker is not muted (this setting does not 
affect the external speakers).

2. Make sure the external speakers are properly connected and 
powered on and that the speakers' volume control is set 
correctly.

3. Use the system volume control available in the operating 
system to make sure the speakers are not muted or to 
increase the volume.

Cannot remove computer cover or access panel.

Cause Solution

Smart Cover Lock, featured on some computers, is locked. Unlock the Smart Cover Lock using Computer Setup.

In case of forgotten password, power loss, or computer 
malfunction, you must manually disable the Smart Cover lock . A 
key to unlock the Smart Cover Lock is not available from HP. Keys 
are typically available from a hardware store.
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Poor performance.

Cause Solution

Processor is too hot. 1. Make sure airflow to the computer is not blocked. Leave a 
10.2-cm (4-inch) clearance on all vented sides of the 
computer and above the monitor to permit the required 
airflow.

2. Make sure fans are connected and working properly (some 
fans only operate when needed).

3. Make sure the processor heat sink is installed properly.

Hard drive is full. Transfer data from the hard drive to create more space on the 
hard drive.

Low on memory. Add more memory.

Hard drive fragmented. Defragment hard drive.

Program previously accessed did not release reserved memory 
back to the system.

Restart the computer.

Virus resident on the hard drive. Run virus protection program.

Too many applications running. 1. Close unnecessary applications to free up memory.

2. Add more memory.

3. Some applications run in the background and can be closed 
by right-clicking on their corresponding icons in the task 
tray. To prevent these applications from launching at 
startup:

In Windows 7:

a. Go to Start > All Programs > Accessories > Run

b. Type msconfig, and then press Enter.

c. On the Startup tab of the System Configuration Utility, 
clear applications that you do not want to launch 
automatically, and the click OK.

In Windows 8.1:

a. On the Start screen, right-click, and then select the All 
apps icon.

b. Under Windows System, click Run.

c. Type msconfig, and then press Enter.

d. On the Startup tab of the System Configuration Utility, 
clear applications that you do not want to launch 
automatically, and the click OK.

In Windows 10:

a. Type msconfig in the taskbar search box, and then 
select msconfig.

b. On the Startup tab of the System Configuration Utility, 
click Open Task Manager..

c. Select applications that you do not want to launch 
automatically, and the click Disable.

Some software applications, especially games, are stressful on 
the graphics subsystem.

1. Lower the display resolution for the current application or 
consult the documentation that came with the application 
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Poor performance.

Cause Solution

for suggestions on how to improve performance by 
adjusting parameters in the application.

2. Add more memory.

3. Upgrade the graphics solution.

Cause unknown. Restart the computer.

Computer powered off automatically and the Power LED flashes red four times and then white two times.

Cause Solution

Processor thermal protection activated:

A fan may be blocked or not turning.

OR

The heat sink is not properly attached to the processor.

1. Ensure that the computer air vents are not blocked and the 
processor cooling fan is running.

2. Open the access panel, press the power button, and see if 
the processor fan (or other system fan) spins. If the fan does 
not spin, make sure the fan cable is plugged onto the system 
board header.

3. If fan a plugged in and not spinning, replace it.

System does not power on and the LEDs on the front of the computer are not flashing.

Cause Solution

System unable to power on. Press and hold the power button for less than 4 seconds. If the 
hard drive LED turns white, then:

1. If equipped with a voltage selector, check that the voltage 
selector (located on the rear of the power supply) is set to 
the appropriate voltage. Proper voltage setting depends on 
your region.

2. Remove the expansion cards one at a time until the 5V_aux 
light on the system board turns on.

3. Replace the system board.

OR

Press and hold the power button for less than 4 seconds. If the 
hard drive LED does not turn on white then:

1. Check that the unit is plugged into a working AC outlet.

2. Open the access panel and check that the power button 
cable is properly connected to the system board.

3. Check that the power supply cables are properly connected 
to the system board.

4. Check to see if the 5V_aux light on the system board is 
turned on. If it is turned on, then replace the power button 
assembly.

5. If the 5V_aux light on the system board is off, then replace 
the power supply.

6. Replace the system board.

Solving general problems 67



Solving power problems
Common causes and solutions for power problems are listed in the following table.

Power supply shuts down intermittently.

Cause Solution

If equipped with a voltage selector, voltage selector switch on 
rear of computer chassis (some models) not switched to correct 
line voltage (115V or 230V).

Select the proper AC voltage using the selector switch.

Power supply will not turn on because of internal power supply 
fault.

Replace the power supply.

Computer powered off automatically and the Power LED flashes red four times and then white two times.

Cause Solution

Processor thermal protection activated:

A fan may be blocked or not turning.

OR

The heat sink is not properly attached to the processor.

1. Ensure that the computer air vents are not blocked and the 
processor cooling fan is running.

2. Open the access panel, press the power button, and see if 
the processor fan (or other system fan) spins. If the fan does 
not spin, make sure the fan cable is plugged onto the system 
board header.

3. If fan a plugged in and not spinning, replace it.

Computer powered off automatically and the Power LED flashes red three times and then white four times.

Cause Solution

Power failure (power supply is overloaded). 1. If equipped with a voltage selector, check that the voltage 
selector, located on the rear of the power supply (some 
models), is set to the appropriate voltage. Proper voltage 
setting depends on your region.

2. Open the access panel and ensure the power supply cable is 
seated into the connector on the system board.

3. Check if a device is causing the problem by removing ALL 
attached devices (such as hard drives or optical drives and 
expansion cards). Power on the system. If the system enters 
POST, then power off and replace one device at a time and 
repeat this procedure until failure occurs. Replace the device 
that is causing the failure. Continue adding devices one at a 
time to ensure all devices are functioning properly.

4. Replace the power supply.

5. Replace the system board.
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Solving hard drive problems
Hard drive error occurs.

Cause Solution

Hard disk has bad sectors or has failed. 1. In Windows 7, click Start, click Computer, and right-click on 
a drive. Select Properties, and then select the Tools tab. 
Under Error-checking click Check Now.

In Windows 8.1, on the Start screen type e, and then select 
File Explorer from the list of applications. In the left 
column, expand Computer, right-click on a drive, select 
Properties, and then select the Tools tab. Under Error 
checking click Check.

In Windows 10, type file in the taskbar search box, and 
then select File Explorer from the list of applications. In the 
left column, expand This PC, right-click on a drive, select 
Properties, and then select the Tools tab. Under Error 
checking click Check.

2. Use a utility to locate and block usage of bad sectors. If 
necessary, reformat the hard disk.

Disk transaction problem.

Cause Solution

Either the directory structure is bad or there is a problem with a 
file.

In Windows 7, click Start, expand Computer, and right-click on a 
drive. Select Properties, and then select the Tools tab. Under 
Error-checking click Check Now.

In Windows 8.1, on the Start screen type e, and then click File 
Explorer from the list of applications. In the left column, expand 
Computer, right-click on a drive, select Properties, and then 
select the Tools tab. Under Error checking click Check.

In Windows 10, type file in the taskbar search box, and then 
select File Explorer from the list of applications. In the left 
column, expand This PC, right-click on a drive, select Properties, 
and then select the Tools tab. Under Error checking click Check.

Drive not found (identified).

Cause Solution

Cable could be loose. Check cable connections.

The system may not have automatically recognized a newly 
installed device.

See reconfiguration directions in the Solving Hardware 
Installation Problems on page 82 section. If the system still 
does not recognize the new device, check to see if the device is 
listed within Computer Setup. If it is listed, the probable cause is a 
driver problem. If it is not listed, the probable cause is a hardware 
problem.

If this is a newly installed drive, run the Computer Setup utility 
and try adding a POST delay under Advanced > Power-On 
Options.
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Drive not found (identified).

Cause Solution

The device is attached to a SATA port that has been hidden in 
Computer Setup.

Run the Computer Setup utility and ensure Device Available is 
selected for the device's SATA port in Security > Device Security.

Drive responds slowly immediately after power-up. Run Computer Setup and increase the POST Delay in Advanced > 
Power-On Options.

Nonsystem disk/NTLDR missing message.

Cause Solution

The system is trying to start from the hard drive but the hard 
drive may have been damaged.

▲ Perform Drive Protection System (DPS) testing in system 
ROM.

System files missing or not properly installed. 1. Insert bootable media and restart the computer.

2. Boot to the windows installation media and select the 
recovery option. If only a restore kit is available, then select 
the File Backup Program option, and then restore the 
system.

3. Install system files for the appropriate operating system.

Hard drive boot has been disabled in Computer Setup. Run the Computer Setup utility and enable the hard drive entry in 
the Storage > Boot Order list.

Bootable hard drive is not attached as first in a multi-hard drive 
configuration.

If attempting to boot from a hard drive, ensure it is attached to 
the system board dark blue SATA connector.

Bootable hard drive is not listed first in the Boot Order. Run the Computer Setup utility and select Storage > Boot Order 
and ensure the bootable hard drive is listed immediately under 
the Hard Drive entry.

Computer will not boot from hard drive.

Cause Solution

The device is attached to a SATA port that has been hidden in 
Computer Setup.

1. Check SATA cable connections.

2. Run the Computer Setup utility and ensure Device Available 
is selected for the device's SATA port in Security > Device 
Security.

Boot order is not correct. Run the Computer Setup utility and change boot sequence in 
Storage  > Boot Order.

Hard Drive's “Emulation Type” is set to “None.” (some models) Run the Computer Setup utility and change the “Emulation Type” 
to “Hard Disk” in the device's details under Storage > Device 
Configuration.

Hard drive is damaged. Observe if the front panel Power LED is blinking RED and if any 
beeps are heard. See Interpreting POST diagnostic front panel 
LEDs on page 109 to determine possible causes for the blinking 
red and beep codes.

See the Worldwide Limited Warranty for terms and conditions.
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Computer seems to be locked up.

Cause Solution

Program in use has stopped responding to commands. 1. Use the task manager to close programs that do not 
respond.

2. Attempt the normal Windows “Shut Down” procedure. If this 
fails, press the power button for four or more seconds to 
turn off the power. To restart the computer, press the power 
button again.

Solving media card reader problems
Media card will not work in a digital camera after formatting it in Windows.

Cause Solution

By default, Windows will format any media card with a capacity 
greater than 32MB with the FAT32 format. Some digital cameras 
use the FAT (FAT16 & FAT12) format and can not operate with a 
FAT32 formatted card.

Either format the media card in the digital camera or select FAT 
file system to format the media card in a computer with Windows.

A write-protected or locked error occurs when attempting to write to the media card.

Cause Solution

Media card is locked. Locking the media card is a safety feature 
that prevents writing to and deleting from an SD/Memory 
Stick/PRO card.

If using an SD card, make sure that the lock tab located on the 
right of the SD card is not in the locked position. If using a Memory 
Stick/PRO card, make sure that the lock tab located on the bottom 
of the Memory Stick/PRO card is not in the locked position.

Can not write to the media card.

Cause Solution

The media card is a read-only memory (ROM) card. Check the manufacturer’s documentation included with your card 
to see if it writable. Refer to the previous section for a list of 
compatible cards.

Media card is locked. Locking the media card is a safety feature 
that prevents writing to and deleting from an SD/Memory 
Stick/PRO card.

If using an SD card, make sure that the lock tab located on the 
right of the SD card is not in the locked position. If using a Memory 
Stick/PRO card, make sure that the lock tab located on the bottom 
of the Memory Stick/PRO card is not in the locked position.

Unable to access data on the media card after inserting it into a slot.

Cause Solution

The media card is not inserted properly, is inserted in the wrong 
slot, or is not supported.

Ensure that the card is inserted properly with the gold contact on 
the correct side. The green LED will light if inserted properly.
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Do not know how to remove a media card correctly.

Cause Solution

The computer’s software is used to safely eject the card. In Windows 7, click Start, select Computer, right-click on the 
corresponding drive icon, and then select Eject. Pull the card out 
of the slot.

In Windows 8.1, on the Start screen, type e, and then click File 
Explorer from the list of applications. Expand Computer, right-
click on the corresponding drive icon, and then select Eject. Pull 
the card out of the slot.

In Windows 10, type file in the taskbar search box, and then 
select File Explorer from the list of applications. In the left 
column, expand This PC, right-click on the corresponding drive 
icon, and then select Eject. Pull the card out of the slot.

NOTE: Never remove the card when the green LED is flashing

After installing the media card reader and booting to Windows, the reader and the inserted cards are not recognized by the 
computer.

Cause Solution

The operating system needs time to recognize the device if the 
reader was just installed into the computer and you are turning 
the PC on for the first time.

Wait a few seconds so that the operating system can recognize 
the reader and the available ports, and then recognize the media 
inserted in the reader.

After inserting a media card in the reader, the computer attempts to boot from the media card.

Cause Solution

The inserted media card has boot capability. 1. If you do not want to boot from the media card, remove it 
during boot or do not select the option to boot from the 
inserted media card during the boot process.

2. During POST (Power On Self-Test), press F9 to modify the 
boot menu.

3. Change the boot sequence in F10 Computer Setup.

Solving display problems
If you encounter display problems, see the documentation that came with the monitor and to the common 
causes and solutions listed in the following table.

Blank screen (no video).

Cause Solution

Monitor is not turned on and the monitor light is not on. Turn on the monitor and check that the monitor light is on.

Bad monitor. Try a different monitor.

The cable connections are not correct. Check the cable connection from the monitor to the computer and 
to the electrical outlet.
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Blank screen (no video).

Cause Solution

You may have a screen blanking utility installed or energy saver 
features are enabled.

Press any key or click the mouse button and type your password 
(if set).

System ROM is corrupted; system is running in Boot Block 
Emergency Recovery Mode (indicated by eight beeps).

Reflash the system ROM with the latest BIOS image.

You are using a fixed-sync monitor and it will not sync at the 
resolution chosen.

Be sure that the monitor can accept the same horizontal scan rate 
as the resolution chosen.

Computer is in Sleep state. Press the power button to resume from Sleep state.

CAUTION: When attempting to resume from Sleep state, do not 
hold down the power button for more than four seconds. 
Otherwise, the computer will shut down and you will lose any 
unsaved data.

Monitor cable is plugged into the wrong connector. Systems may have a monitor connection on both the 
motherboard or an add-in card. Try moving the monitor 
connection to a different connector on the back of the computer

Monitor settings in the computer are not compatible with the 
monitor.

1. In Control Panel, select Category from the View by list, then 
under Appearance and Personalization, select Adjust 
screen resolution.

To access Control Panel in Windows 7, click Start, and then 
select Control Panel.

To access Control Panel in Windows 8.1, from the Start 
screen, type c, and then select Control Panel from the list of 
applications.

To access Control Panel in Windows 10, type control 
panel in the taskbar search box, and then select Control 
Panel from the list of applications.

2. Expand the Resolution box, and then use the sliding control 
to reset the resolution.

Monitor is configured to use an input that is not active. Use the monitor's on-screen menu controls to select the input 
that is being driven by the system. Refer to the monitor's user 
documentation for more information on the on-screen controls 
and settings.

Blank screen and the power LED flashes Red five times, once every second, followed by a two second pause, and the computer 
beeps five times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Pre-video memory error. 1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty module.

3. Replace third-party memory with HP memory.

4. Replace the system board.
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Blank screen and the power LED flashes Red six times, once every second, followed by a two second pause, and the computer 
beeps six times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Pre-video graphics error. For systems with a graphics card:

1. Reseat the graphics card (if applicable). Power on the 
system.

2. Replace the graphics card (if applicable).

3. Replace the system board.

For systems with integrated graphics, replace the system board.

Blank screen and the power LED flashes Red seven times, once every second, followed by a two second pause, and the computer 
beeps seven times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

System board failure (ROM detected failure prior to video). Replace the system board.

Monitor does not function properly when used with energy saver features.

Cause Solution

Monitor without energy saver capabilities is being used with 
energy saver features enabled.

Disable monitor energy saver feature.

Dim characters.

Cause Solution

The brightness and contrast controls are not set properly. Adjust the monitor brightness and contrast controls.

Cables are not properly connected. Check that the graphics cable is securely connected to the 
graphics card (if applicable) or video connector and the monitor.

Blurry video or requested resolution cannot be set.

Cause Solution

If the graphics controller was upgraded, the correct graphics 
drivers may not be loaded.

Install the video drivers included in the upgrade kit.

Monitor is not capable of displaying requested resolution. Change requested resolution.

Graphics card is bad. Replace the graphics card.
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The picture is broken up, rolls, jitters, or flashes.

Cause Solution

The monitor connections may be incomplete or the monitor may 
be incorrectly adjusted.

1. Be sure the monitor cable is securely connected to the 
computer.

2. In a two-monitor system or if another monitor is in close 
proximity, be sure the monitors are not interfering with each 
other’s electromagnetic field by moving them apart.

3. Fluorescent lights or fans may be too close to the monitor.

Monitor needs to be degaussed. Degauss the monitor. Refer to the documentation that came with 
the monitor for instructions.

Image is not centered.

Cause Solution

Position may need adjustment. Press the monitor's Menu button to access the OSD menu. Select 
ImageControl/ Horizontal Position or Vertical Position to adjust 
the horizontal or vertical position of the image.

“No Connection, Check Signal Cable” displays on screen.

Cause Solution

Monitor video cable is disconnected. Connect the video cable between the monitor and computer.

CAUTION: Ensure that the computer power is off while 
connecting the video cable.

“Out of Range” displays on screen.

Cause Solution

Video resolution and refresh rate are set higher than what the 
monitor supports.

Restart the computer and enter Safe Mode. Change the settings to 
a supported setting then restart the computer so that the new 
settings take effect.

To enter Safe Mode in Windows 7:

1. Restart the computer.

2. Press and hold the F8 key as your computer restarts, before 
the Windows logo appears. If the Windows logo appears, 
you must restart the computer and try again.

3. On the Advanced Boot Options screen, use the arrow keys to 
highlight the safe mode option you want, and then press 
Enter.

4. Log on to your computer with a user account that has 
administrator rights.

When your computer is in safe mode, Safe Mode displays in 
the corners of your monitor. To exit safe mode, restart your 
computer and let Windows start normally.

To enter Safe Mode in Windows 8.1:
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“Out of Range” displays on screen.

Cause Solution

1. Press the Windows logo + l to open the Settings charm.

2. Select Change PC Settings, select General, and then under 
Advanced startup, click Restart now.

3. Select Troubleshoot, select Advanced options, select 
Startup Settings, and then click Restart.

4. Use the function keys or number keys to select the safe 
mode option you want.

When your computer is in safe mode, Safe Mode displays in 
the corners of your monitor. To exit safe mode, restart your 
computer and let Windows start normally.

To enter Safe Mode in Windows 10:

1. Log into the computer using an Administrator account.

2. Type msconfig in the taskbar search box, and then select 
msconfig from the list of applications.

3. Click the Boot tab, select Safe boot and then click OK.

High pitched noise coming from inside a flat panel monitor.

Cause Solution

Brightness and/or contrast settings are too high. Lower brightness and/or contrast settings.

Fuzzy focus; streaking, ghosting, or shadowing effects; horizontal scrolling lines; faint vertical bars; or unable to center the 
picture on the screen (flat panel monitors using an analog VGA input connection only).

Cause Solution

Flat panel monitor’s internal digital conversion circuits may be 
unable to correctly interpret the output synchronization of the 
graphics card.

1. Select the monitor’s Auto-Adjustment option in the 
monitor’s on-screen display menu.

2. Manually synchronize the Clock and Clock Phase on-screen 
display functions. To download a SoftPaq that will assist you 
with the synchronization, go to the following Web site, 
select the appropriate monitor, and download either 
SP32347 or SP32202: http://www.hp.com/support

Graphics card is not seated properly or is bad (some models). 1. Reseat the graphics card.

2. Replace the graphics card.

Certain typed symbols do not appear correct.

Cause Solution

The font you are using does not support that particular symbol. Use the Character Map to locate and select the appropriate 
symbol. You can copy the symbol from the Character Map into a 
document.
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Certain typed symbols do not appear correct.

Cause Solution

In Windows 7, click Start, select All Programs, select Accessories, 
select System Tools, and then select Character Map.

In Windows 8.1, on the Start screen, type ch, and then select 
Character Map  from the list of applications.

In Windows 10, type ch in the taskbar search box, and then select 
Character Map from the list of applications.

Solving audio problems
If the computer has audio features and you encounter audio problems, see the common causes and solutions 
listed in the following table.

Sound cuts in and out.

Cause Solution

Processor resources are being used by other open applications. Shut down all open processor-intensive applications.

Sound does not come out of the speaker or headphones.

Cause Solution

Software volume control is turned down or muted. Double-click the Speaker icon on the taskbar, then make sure 
that Mute is not selected and use the volume slider to adjust the 
volume.

NOTE: In Windows 8.1, the taskbar is available at the bottom of 
the Desktop screen.

Audio is hidden in Computer Setup. Enable the audio in Computer Setup: Security > Device Security > 
System Audio.

The external speakers are not turned on. Turn on the external speakers.

The audio device may be connected to the wrong jack. Ensure that the device is connected to the correct jack on the 
computer. The rear audio jack output is the green receptacle. The 
speakers should be plugged into the line-out jack and the 
headphones should be plugged into the headphone jack.

External speakers plugged into the wrong audio jack on a recently 
installed sound card.

See the sound card documentation for proper speaker connection. 
The rear audio jack output is the green receptacle.

Headphones or devices connected to the line-out connector mute 
the internal speaker.

Turn on and use headphones or external speakers, if connected, 
or disconnect headphones or external speakers.

Computer is in Sleep state. Press the power button to resume from Sleep state.

CAUTION: When attempting to resume from Sleep state, do not 
hold down the power button for more than four seconds. 
Otherwise, the computer will shut down and you will lose any 
unsaved data.

Internal speaker is disabled in Computer Setup. Enable the internal speaker in Computer Setup. Select Advanced > 
Device Options > Internal Speaker.
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Sound does not come out of the speaker or headphones.

Cause Solution

The application is set to use a different audio device than 
speakers.

Some graphics cards support audio over the DisplayPort 
connection (if applicable), so multiple audio devices may be listed 
in Device Manager. Make sure the correct device is being used.

To access Device Manager in Windows 7, click Start, select Control 
Panel, and then select Device Manager.

To access Device Manager in Windows 8.1, from the Start screen, 
type c, select Control Panel from the list of applications, and then 
select Device Manager.

To access Device Manager in Windows 10, type device 
manager in the taskbar search box, and then select Device 
Manager from the list of applications.

Some applications can select which audio output device is used. Make sure the application has selected the correct audio device.

The operating system controls may be set to use a different audio 
device as the default output device than what is expected.

Set the operating system to use the correct audio device.

Sound from headphones is not clear or muffled.

Cause Solution

Headphones are plugged into the rear audio output connector. 
The rear audio output connector is for powered audio devices and 
is not designed for headphone use.

Plug the headphones into the headphone connector on the front 
of the computer.

Computer appears to be locked up while recording audio.

Cause Solution

The hard disk may be full. Before recording, make sure there is enough free space on the 
hard disk. You can also try recording the audio file in a 
compressed format.

Line-in jack is not functioning properly.

Cause Solution

Jack has been reconfigured in the audio driver or application 
software.

In the audio driver or application software, reconfigure the jack or 
set the jack to its default value.

There is no sound or sound volume is too low.

Cause Solution

The application is set to use a different audio device than 
speakers.

Some graphics cards support audio over the DisplayPort 
connection (if applicable), so multiple audio devices may be listed 
in Device Manager. Make sure the correct device is being used.

To access Device Manager in Windows 7, click Start, select Control 
Panel, and then select Device Manager.
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There is no sound or sound volume is too low.

Cause Solution

To access Device Manager in Windows 8.1, from the Start screen, 
type c, select Control Panel from the list of applications, and then 
select Device Manager.

To access Device Manager in Windows 10, type device 
manager in the taskbar search box, and then select Device 
Manager from the list of applications.

Some applications can select which audio output device is used. Make sure the application has selected the correct audio device.

The operating system controls may be set to use a different audio 
device as the default output device than what is expected.

Set the operating system to use the correct audio device.

Solving printer problems
If you encounter printer problems, see the documentation that came with the printer and to the common 
causes and solutions listed in the following table.

Printer will not print.

Cause Solution

Printer is not turned on and online. Turn the printer on and make sure it is online.

The correct printer drivers for the application are not installed. 1. Install the correct printer driver for the application.

2. Try printing using the MS-DOS command:

DIR C:\ > [printer port]

where [printer port] is the address of the printer being 
used. If the printer works, reload the printer driver.

To run MS-DOS commands, press the Windows key + r, type cmd 
in the Open box, and then click OK.

If you are on a network, you may not have made the connection 
to the printer.

Make the proper network connections to the printer.

Printer may have failed. Run printer self-test.

Printer will not turn on.

Cause Solution

The cables may not be connected properly. Reconnect all cables and check the power cord and electrical 
outlet.

Printer prints garbled information.

Cause Solution

The correct printer driver for the application is not installed. Install the correct printer driver for the application.
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Printer prints garbled information.

Cause Solution

The cables may not be connected properly. Reconnect all cables.

Printer memory may be overloaded. Reset the printer by turning it off for one minute, then turn it back 
on.

Printer will not print.

Cause Solution

The printer may be out of paper. Check the paper tray and refill it if it is empty.

Solving keyboard and mouse problems
If you encounter keyboard or mouse problems, see the documentation that came with the equipment and to 
the common causes and solutions listed in the following table.

A wireless keyboard/mouse is not working correctly. Symptoms include lagging mouse movement, jumpy mouse/keyboard, or no 
function of mouse/keyboard and external drive.

Cause Solution

If your computer is equipped with USB 3.0 ports, connected USB 
3.0 devices can interfere with the wireless keyboard USB receiver.

Connect the wireless keyboard USB receiver to a USB 2.0 port that 
is separated from ports with USB 3.0 devices. If you still 
experience interference, you may have to place the connectors 
farther apart using an external USB hub.

Keyboard commands and typing are not recognized by the computer.

Cause Solution

Keyboard connector is not properly connected. Shut down the computer, reconnect the keyboard to the back of 
the computer, and then restart the computer.

Program in use has stopped responding to commands. Shut down your computer using the mouse and then restart the 
computer.

Keyboard needs repairs. See the Worldwide Limited Warranty for terms and conditions.

Computer is in Sleep state. Press the power button to resume from Sleep state.

CAUTION: When attempting to resume from Sleep date, do not 
hold down the power button for more than four seconds. 
Otherwise, the computer will shut down and you will lose any 
unsaved data.

Cursor will not move using the arrow keys on the keypad.

Cause Solution

The Num Lock key is on. Press the Num Lock key. The Num Lock light should be off if you 
want to use the arrow keys on the keypad. You can disable or 

80 Chapter 7   Troubleshooting without diagnostics



Cursor will not move using the arrow keys on the keypad.

Cause Solution

enable the Num Lock key in Computer Setup at Advanced > 
Device Options.

Mouse does not respond to movement or is too slow.

Cause Solution

Mouse connector is not properly plugged into the back of the 
computer.

Shut down the computer using the keyboard.

Windows 7:

1. Press the Ctrl and Esc keys at the same time (or press the 
Windows logo key) to display the Start menu.

2. Use the arrow keys to select Shut Down and then press 
Enter.

3. After the shutdown is complete, plug the mouse connector 
into the back of the computer (or the keyboard) and restart.

Windows 8.1:

1. Press the Windows logo + l to open the Settings charm.

2. Use the arrow keys to select Power, and then press Enter.

3. Use the arrow keys to select Shut Down, and then press 
Enter.

4. After the shutdown is complete, plug the mouse connector 
into the back of the computer (or the keyboard) and restart.

Windows 10:

1. Press the Ctrl and Esc keys at the same time (or press the 
Windows logo key) to display the Start menu.

2. Use the arrow keys to scroll to and select the power icon at 
the top right on the menu, and then press Enter.

3. Use the arrow keys to select Shut Down, and then press 
Enter.

4. After the shutdown is complete, plug the mouse connector 
into the back of the computer (or the keyboard) and restart.

Program in use has stopped responding to commands. Shut down the computer using the keyboard then restart the 
computer.

Mouse may need cleaning. Remove the roller ball cover on the mouse and clean the internal 
components.

Mouse may need repair. See the Worldwide Limited Warranty for terms and conditions.

Computer is in Sleep state. Press the power button to resume from Sleep state.

CAUTION: When attempting to resume from Sleep state, do not 
hold down the power button for more than four seconds. 
Otherwise, the computer will shut down and you will lose any 
unsaved data.
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Mouse will only move vertically, horizontally, or movement is jerky.

Cause Solution

Mouse roller ball or the rotating encoder shafts that make contact 
with the ball are dirty.

Remove roller ball cover from the bottom of the mouse and clean 
the internal components with a mouse cleaning kit available from 
most computer stores.

Solving Hardware Installation Problems
You may need to reconfigure the computer when you add or remove hardware, such as an additional drive or 
expansion card. If you install a plug and play device, Windows automatically recognizes the device and 
configures the computer. If you install a non-plug and play device, you must reconfigure the computer after 
completing installation of the new hardware. In Windows, use the Add Hardware Wizard and follow the 
instructions that appear on the screen.

To open the Add Hardware Wizard, open a Command Prompt and open hdwwiz.exe.

WARNING! When the computer is plugged into an AC power source, voltage is always applied to the system 
board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be sure to disconnect 
the power cord from the wall outlet and allow the internal system components to cool before touching.

Table 7-1  Solving Hardware Installation Problems

A new device is not recognized as part of the system.

Cause Solution

Device is not seated or connected properly. Ensure that the device is properly and securely connected and 
that pins in the connector are not bent down.

Cable(s) of new external device are loose or power cables are 
unplugged.

Ensure that all cables are properly and securely connected and 
that pins in the cable or connector are not bent down.

Power switch of new external device is not turned on. Turn off the computer, turn on the external device, then turn on 
the computer to integrate the device with the computer system.

When the system advised you of changes to the configuration, 
you did not accept them.

Reboot the computer and follow the instructions for accepting the 
changes.

A plug and play board may not automatically configure when 
added if the default configuration conflicts with other devices.

Use Windows Device Manager to deselect the automatic settings 
for the board and choose a basic configuration that does not 
cause a resource conflict. You can also use Computer Setup to 
reconfigure or disable devices to resolve the resource conflict.

To access Device Manager in Windows 7, click Start, select Control 
Panel, and then select Device Manager.

To access Device Manager in Windows 8.1, from the Start screen, 
type c, select Control Panel from the list of applications, and then 
select Device Manager.

To access Device Manager in Windows 10, type device 
manager in the taskbar search box, and then select Device 
Manager from the list of applications.

USB ports on the computer are disabled in Computer Setup. Run the Computer Setup utility and ensure that Device available 
is selected for appropriate USB ports under Security > USB 
Security.
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Computer will not start.

Cause Solution

Wrong memory modules were used in the upgrade or memory 
modules were installed in the wrong location.

1. Review the documentation that came with the system to 
determine if you are using the correct memory modules and 
to verify the proper installation.

NOTE: DIMM1 or XMM1 must always be installed. DIMM1 
must be installed before DIMM2, and DIMM3 must be 
installed before DIMM4.

2. Observe the beeps and LED lights on the front of the 
computer. Beeps and flashing LEDs are codes for specific 
problems.

3. If you still cannot resolve the issue, contact Customer 
Support.

Power LED flashes Red three times and then white two times.

Cause Solution

Memory is installed incorrectly or is bad. CAUTION: To avoid damage to the DIMMs or the system board, 
you must unplug the computer power cord before attempting to 
reseat, install, or remove a DIMM module.

1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty module.

NOTE: DIMM1 or XMM1 must always be installed. DIMM1 
must be installed before DIMM2, and DIMM3 must be 
installed before DIMM4

3. Replace third-party memory with HP memory.

4. Replace the system board.

Solving Network Problems
Some common causes and solutions for network problems are listed in the following table. These guidelines 
do not discuss the process of debugging the network cabling.

Table 7-2  Solving Network Problems

Network driver does not detect network controller.

Cause Solution

Network controller is disabled. 1. Run Computer Setup and enable network controller.

2. Enable the network controller in the operating system using 
Device Manager.

To access Device Manager in Windows 7, click Start, select 
Control Panel, and then select Device Manager.

To access Device Manager in Windows 8.1, from the Start 
screen, type c, select Control Panel from the list of 
applications, and then select Device Manager.
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Table 7-2  Solving Network Problems (continued)

Network driver does not detect network controller.

Cause Solution

To access Device Manager in Windows 10, type device 
manager in the taskbar search box, and then select Device 
Manager from the list of applications.

Incorrect network driver. Check the network controller documentation for the correct driver 
or obtain the latest driver from the manufacturer’s Web site.

Network status link light never flashes.

NOTE: The network status light is supposed to flash when there is network activity.

Cause Solution

No active network is detected. Check cabling and network equipment for proper connection.

Network controller is not set up properly. Check for the device status within Windows, such as Device 
Manager for driver load and the Network Connections applet 
within Windows for link status.

To access Device Manager in Windows 7, click Start, select Control 
Panel, and then select Device Manager.

To access Device Manager in Windows 8.1, from the Start screen, 
type c, select Control Panel from the list of applications, and then 
select Device Manager.

To access Device Manager in Windows 10, type device 
manager in the taskbar search box, and then select Device 
Manager from the list of applications.

Network controller is disabled. 1. Run Computer Setup and enable network controller.

2. Enable the network controller in the operating system using 
Device Manager.

To access Device Manager in Windows 7, click Start, select 
Control Panel, and then select Device Manager.

To access Device Manager in Windows 8.1, from the Start 
screen, type c, select Control Panel from the list of 
applications, and then select Device Manager.

To access Device Manager in Windows 10, type device 
manager in the taskbar search box, and then select Device 
Manager from the list of applications.

Network driver is not properly loaded. Reinstall network drivers.

System cannot autosense the network. Disable auto-sensing capabilities and force the system into the 
correct operating mode.
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Diagnostics reports a failure.

Cause Solution

The cable is not securely connected. Ensure that the cable is securely attached to the network 
connector and that the other end of the cable is securely attached 
to the correct device.

The cable is attached to the incorrect connector. Ensure that the cable is attached to the correct connector.

There is a problem with the cable or a device at the other end of 
the cable.

Ensure that the cable and device at the other end are operating 
correctly.

Network controller interrupt is shared with an expansion board. Under the Computer Setup Advanced menu, change the resource 
settings for the board.

The network controller is defective. Contact an authorized service provider.

Diagnostics passes, but the computer does not communicate with the network.

Cause Solution

Network drivers are not loaded, or driver parameters do not 
match current configuration.

Make sure the network drivers are loaded and that the driver 
parameters match the configuration of the network controller.

Make sure the correct network client and protocol is installed.

The network controller is not configured for this computer. Select the Network and Sharing Center icon in the Control Panel 
and configure the network controller.

To access Control Panel in Windows 7, click Start, and then select 
Control Panel.

To access Control Panel in Windows 8.1, from the Start screen, 
type c, and then select Control Panel.

To access Control Panel in Windows 10, type control panel in 
the taskbar search box, and then select Control Panel from the 
list of applications.

Network controller stopped working when an expansion board was added to the computer.

Cause Solution

Network controller interrupt is shared with an expansion board. Under the Computer Setup Advanced menu, change the resource 
settings for the board.

The network controller requires drivers. Verify that the drivers were not accidentally deleted when the 
drivers for a new expansion board were installed.

The expansion board installed is a network card (NIC) and conflicts 
with the embedded NIC.

Under the Computer Setup Advanced menu, change the resource 
settings for the board.

Network controller stops working without apparent cause.

Cause Solution

The files containing the network drivers are corrupted. Reinstall the network drivers using the Recovery Disc Set in 
Windows 7 or Windows recovery tools in Windows 8.1.
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Table 7-2  Solving Network Problems (continued)

Network controller stops working without apparent cause.

Cause Solution

If necessary, download the softpaq from the web (from a different 
computer).

The cable is not securely connected. Ensure that the cable is securely attached to the network 
connector and that the other end of the cable is securely attached 
to the correct device.

The network controller is defective. Contact an authorized service provider.

New network card will not boot.

Cause Solution

New network card may be defective or may not meet industry-
standard specifications.

Install a working, industry-standard NIC, or change the boot 
sequence to boot from another source.

Cannot connect to network server when attempting Remote System Installation.

Cause Solution

The network controller is not configured properly. Verify Network Connectivity, that a DHCP Server is present, and 
that the Remote System Installation Server contains the NIC 
drivers for your NIC.

System setup utility reports unprogrammed EEPROM.

Cause Solution

Unprogrammed EEPROM. Contact an authorized service provider.

Solving memory problems
If you encounter memory problems, some common causes and solutions are listed in the following table.

CAUTION: Power may still be supplied to the DIMMs when the computer is turned off (depending on the 
Management Engine (ME) settings). To avoid damage to the DIMMs or the system board, you must unplug the 
computer power cord before attempting to reseat, install, or remove a memory module.

For those systems that support ECC memory, HP does not support mixing ECC and non-ECC memory. 
Otherwise, the computer will not boot the operating system.

NOTE: The memory count will be affected by configurations with the Management Engine (ME) enabled. The 
ME uses 8MB of system memory in single channel mode or 16MB of memory in dual-channel mode to 
download, decompress, and execute the ME firmware for Out-of-Band (OOB), third-party data storage, and 
other management functions.
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System will not boot or does not function properly after installing additional memory modules.

Cause Solution

A memory module is not installed in the DIMM1 or XMM1 socket. Ensure that a memory module is installed in the DIMM1 or XMM1 
socket on the system board. This socket must be populated with a 
memory module.

Memory module is not the correct type or speed grade for the 
system or the new memory module is not seated properly.

Replace module with the correct industry-standard device for the 
computer. On some models, ECC and non-ECC memory modules 
cannot be mixed.

Out of memory error.

Cause Solution

You have run out of memory to run the application. Check the application documentation to determine the memory 
requirements.

Memory count during POST is wrong.

Cause Solution

The memory modules may not be installed correctly. Check that the memory modules have been installed correctly and 
that proper modules are used.

Integrated graphics may use system memory. No action required.

Insufficient memory error during operation.

Cause Solution

Too many Terminate and Stay Resident programs (TSRs) are 
installed.

Delete any TSRs that you do not need.

You have run out of memory for the application. Check the memory requirements for the application or add more 
memory to the computer.

Power LED flashes Red five times, once every second, followed by a two second pause, and the computer beeps five times. (Beeps 
stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Memory is installed incorrectly or is bad. 1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty module.

3. Replace third-party memory with HP memory.

4. Replace the system board.
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Solving CD-ROM and DVD problems
If you encounter CD-ROM or DVD problems, see the common causes and solutions listed in the following table 
or to the documentation that came with the optional device.

System will not boot from CD-ROM or DVD drive.

Cause Solution

The device is attached to a SATA port that has been hidden in the 
Computer Setup utility.

Run the Computer Setup utility and ensure Device Available is 
selected for the device's SATA port in Security > Device Security.

Removable Media Boot is disabled in the Computer Setup utility. Run the Computer Setup utility and enable booting to removable 
media in Storage  > Storage Options. Ensure CD-ROM is enabled 
in Storage > Boot Order.

Network Boot is enabled in Computer Setup. Run the Computer Setup utility and disable Network Boot in 
Security > Network Boot.

Non-bootable CD in drive. Try a bootable CD in the drive.

Boot order not correct. Run the Computer Setup utility and change boot sequence in 
Storage > Boot Order.

Drive not found (identified).

Cause Solution

Cable could be loose. Check cable connections.

The system may not have automatically recognized a newly 
installed device.

See reconfiguration directions in the Solving Hardware 
Installation Problems on page 82 section. If the system still does 
not recognize the new device, check to see if the device is listed 
within Computer Setup. If it is listed, the probable cause is a driver 
problem. If it is not listed, the probable cause is a hardware 
problem.

If this is a newly installed drive, run the Computer Setup utility 
and try adding a POST delay under Advanced  > Power-On 
Options.

The device is attached to a SATA port that has been hidden in 
Computer Setup.

Run the Computer Setup utility and ensure Device Available is 
selected for the device's SATA port in Security > Device Security.

Drive responds slowly immediately after power-up. Run Computer Setup and increase the POST Delay in Advanced > 
Power-On Options.

CD-ROM or DVD devices are not detected or driver is not loaded.

Cause Solution

Drive is not connected properly or not properly configured. See the documentation that came with the optional device.

Movie will not play in the DVD drive.

Cause Solution

Movie may be regionalized for a different country. See the documentation that came with the DVD drive.
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Movie will not play in the DVD drive.

Cause Solution

Decoder software is not installed. Install decoder software.

Damaged media. Replace media.

Movie rating locked out by parental lock. Use DVD software to remove parental lock.

Media installed upside down. Reinstall media.

Cannot eject compact disc (tray-load unit).

Cause Solution

Disc not properly seated in the drive. Turn off the computer and insert a thin metal rod into the 
emergency eject hole and push firmly. Slowly pull the tray out 
from the drive until the tray is fully extended, then remove 
the disc.

CD-ROM, CD-RW, DVD-ROM, or DVD-R/RW drive cannot read a disc or takes too long to start.

Cause Solution

Media is corrupt. Try different media to confirm whether media is valid.

Media has been inserted upside down. Re-insert the media with the label facing up.

The DVD-ROM drive takes longer to start because it has to 
determine the type of media played, such as audio or video.

Wait at least 30 seconds to let the DVD-ROM drive determine the 
type of media being played. If the disc still does not start, read the 
other solutions listed for this topic.

CD or DVD disc is dirty. Clean CD or DVD with a CD cleaning kit, available from most 
computer stores.

Windows does not detect the CD-ROM or DVD-ROM drive. 1. Use Device Manager to remove or uninstall the device.

To access Device Manager in Windows 7, click Start, select 
Control Panel, and then select Device Manager.

To access Device Manager in Windows 8.1, from the Start 
screen, type c, select Control Panel from the list of 
applications, and then select Device Manager.

To access Device Manager in Windows 10, type device 
manager in the taskbar search box, and then select Device 
Manager from the list of applications.

2. Restart the computer and let Windows detect the CD or DVD 
driver.

Recording or copying CDs is difficult or impossible.

Cause Solution

Wrong or poor quality media type. 1. Try using a slower speed when recording.

2. Verify that you are using the correct media for the drive.
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Recording or copying CDs is difficult or impossible.

Cause Solution

3. Try a different brand of media. Quality varies widely 
between manufacturers.

Solving USB flash drive problems
If you encounter USB flash drive problems, common causes and solutions are listed in the following table.

USB flash drive is not seen as a drive letter in Windows.

Cause Solution

The drive letter after the last physical drive is not available. Change the default drive letter for the flash drive in Windows.

USB flash drive not found (identified).

Cause Solution

The device is attached to a USB port that has been hidden in 
Computer Setup.

Run the Computer Setup utility and enable USB ports in 
Security > USB Security.

The device was not properly seated before power-up. Ensure the device is fully inserted into the USB port before 
applying power to the system

System will not boot from USB flash drive.

Cause Solution

Boot order is not correct. Run the Computer Setup utility and change boot sequence in 
Storage > Boot Order.

Removable Media Boot is disabled in the Computer Setup utility. Run the Computer Setup utility and enable booting to removable 
media in Storage > Storage Options. Ensure USB is enabled in 
Storage > Boot Order.

The computer boots to DOS after making a bootable flash drive.

Cause Solution

Flash drive is bootable. Install the flash drive only after the operating system boots.

Flash drive is defective. Try a different flash drive.
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Solving front panel component problems
If you encounter problems with devices connected to the front panel, refer to the common causes and 
solutions listed in the following table.

A USB device, headphone, or microphone is not recognized by the computer.

Cause Solution

Device is not properly connected. 1. Turn off the computer.

2. Reconnect the device to the front of the computer and 
restart the computer.

The device does not have power. If the USB device requires AC power, be sure one end is connected 
to the device and one end is connected to a live outlet.

The correct device driver is not installed. 1. Install the correct driver for the device.

2. You might need to reboot the computer.

The cable from the device to the computer does not work. 1. If possible, replace the cable.

2. Restart the computer.

The device is not working. 1. Replace the device.

2. Restart the computer.

USB ports on the computer are disabled in Computer Setup. Run the Computer Setup utility and ensure that the USB ports are 
set to Enabled in Security > USB Security.

Solving Internet access problems
If you encounter Internet access problems, consult your Internet Service Provider (ISP) or refer to the common 
causes and solutions listed in the following table.

Unable to connect to the Internet.

Cause Solution

Internet Service Provider (ISP) account is not set up properly. Verify Internet settings or contact your ISP for assistance.

Web browser is not set up properly. Verify that the Web browser is installed and set up to work with 
your ISP.

Cable/DSL modem is not plugged in. Plug in cable/DSL modem. You should see a “power” LED light on 
the front of the cable/DSL modem.

Cable/DSL service is not available or has been interrupted due to 
bad weather.

Try connecting to the Internet at a later time or contact your ISP. 
(If the cable/DSL service is connected, the “cable” LED light on the 
front of the cable/DSL modem will be on.)

The CAT5 UTP cable is disconnected. Connect the CAT5 UTP cable between the cable modem and the 
computers’s RJ-45 connector. (If the connection is good, the “PC” 
LED light on the front of the cable/DSL modem will be on.)

IP address is not configured properly. Contact your ISP for the correct IP address.

Cookies are corrupted. (A “cookie” is a small piece of information 
that a Web server can store temporarily with the Web browser. 
This is useful for having the browser remember some specific 
information that the Web server can later retrieve.)

Windows 7:

1. Select Start > Control Panel.

2. Click Internet Options.
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Unable to connect to the Internet.

Cause Solution

3. In the Browsing history section on the General tab, click the 
Delete button.

4. Select the Cookies check box and click the Delete button.

Windows 8.1:

1. From the Start screen, type c, and then select Control Panel 
from the list of applications.

2. Click Internet Options.

3. In the Browsing history section on the General tab, click the 
Delete button.

4. Select the Cookies check box and click the Delete button.

Windows 10:

1. Type control panel in the taskbar search box, and then 
select Control Panel from the list of applications.

2. Click Internet Options.

3. In the Browsing history section, click the Delete button.

4. Select the Cookies and website data check box and click the 
Delete button.

Cannot automatically launch Internet programs.

Cause Solution

You must log on to your ISP before some programs will start. Log on to your ISP and launch the desired program.
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Solving software problems
Most software problems occur as a result of the following:

● The application was not installed or configured correctly.

● There is insufficient memory available to run the application.

● There is a conflict between applications.

● Be sure that all the needed device drivers have been installed.

● If you have installed an operating system other than the factory-installed operating system, check to be 
sure it is supported on the system.

If you encounter software problems, see the applicable solutions listed in the following table.

Computer will not continue and the HP logo does not display.

Cause Solution

ROM issue - POST error has occurred. Observe the beeps and LED lights on the front of the computer. 
See Interpreting POST diagnostic front panel LEDs on page 109 to 
determine possible causes.

See the Worldwide Limited Warranty for terms and conditions.

“Illegal Operation has Occurred” error message is displayed.

Cause Solution

Software being used is not Microsoft-certified for your version of 
Windows.

Verify that the software is certified by Microsoft for your version 
of Windows (see program packaging for this information).

Configuration files are corrupt. If possible, save all data, close all programs, and restart the 
computer.
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8 HP PC Hardware Diagnostics

To help troubleshoot and diagnose failures, use the UEFI-based hardware diagnostic solution that HP includes 
on all products. This tool can even be used if the computer will not boot to the operating system.

Why run HP PC Hardware Diagnostics
The HP PC Hardware Diagnostic tools simplify the process of diagnosing hardware issues and expedite the 
support process when issues are found. The tools save time by pinpointing the component that needs to be 
replaced.

● Isolate true hardware failures: The diagnostics run outside of the operating system so they effectively 
isolate hardware failures from issues that may be caused by the operating system or other software 
components.

● Failure ID: When a failure is detected that requires hardware replacement, a 24-digit Failure ID is 
generated. This ID can then be provided to the call agent, who will either schedule support or provide 
replacement parts.

How to access and run HP PC Hardware Diagnostics
You can run the diagnostics from one of three places, depending on your preference and the health of the 
computer.

1. Turn on the computer and press Esc repeatedly until the BIOS Boot Menu appears.

2. Press F2 or select Diagnostics (F2).

Pressing F2 signals the system to search for the diagnostics in the following locations:

a. A connected USB drive (to download the diagnostics tools to a USB drive, see the instructions in 
Downloading HP PC Hardware Diagnostics (UEFI) to a USB device on page 95)

b. The hard disk drive

c. A core set of diagnostics in the BIOS (for memory and hard disk drive) that are accessible only if the 
USB or hard disk drive versions are not detected
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Downloading HP PC Hardware Diagnostics (UEFI) to a USB device
NOTE: Instructions for downloading HP PC Hardware Diagnostics (UEFI) are provided in English only.

There are two options to download HP PC Hardward Diagnostics to USB device.

Option 1: HP PC Diagnostics homepage–Provides access to the latest UEFI version

1. Go to http://www.hp.com/go/techcenter/pcdiags.

2. Click the UEFI Dowload link, and then select Run.

Option 2: Support and Drivers pages–Provides downloads for a specific product for earlier and later 
versions.

1. Go to http://www.hp.com.

2. Point to Support, located at the top of the page, and then click Download Drivers.

3. In the text box, enter the product name, and then click Go.

– or –

Click Find Now to let HP automatically detect your product.

4. Select your computer model, and then select your operating system.

5. In the Diagnostic section, click HP UEFI Support Environment.

6. Click Download, and then select Run.
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9 Backup and Recovery

Backing up, restoring, and recovering in Windows 10
This section provides information about the following processes. The information in the section is standard 
procedure for most products.

● Creating recovery media and backups

● Restoring and recovering your system

For additional information, refer to Help and Support.

▲ Type help in the taskbar search box, and then select Help and Support.

Creating recovery media and backups

The following methods of creating recovery media and backups are available on select products only. Choose 
the available method according to your computer model.

● Use HP Recovery Manager to create HP Recovery media after you successfully set up the computer. This 
step creates a backup of the HP Recovery partition on the computer. The backup can be used to reinstall 
the original operating system in cases where the hard drive is corrupted or has been replaced. For 
information on creating recovery media, see Creating HP Recovery media (select products only) 
on page 96. For information on the recovery options that are available using the recovery media, see 
What you need to know before you get started on page 98.

● Use Windows tools to create system restore points and create backups of personal information.

For more information, see Using Windows tools on page 97.

NOTE: If storage is 32 GB or less, Microsoft System Restore is disabled by default.

Creating HP Recovery media (select products only)

If possible, check for the presence of the Recovery partition and the Windows partition. From the Start menu, 
select File Explorer.

● If your computer does not list the Windows partition and the Recovery partition, you can obtain recovery 
media for your system from support. See the Worldwide Telephone Numbers booklet included with the 
computer. You can also find contact information on the HP website. Go to http://www.hp.com/support, 
select your country or region, and follow the on-screen instructions.

You can use Windows tools to create system restore points and create backups of personal information, 
see Using Windows tools on page 97.

● If your computer does list the Recovery partition and the Windows partition, you can use HP Recovery 
Manager to create recovery media after you successfully set up the computer. HP Recovery media can be 
used to perform system recovery if the hard drive becomes corrupted. System recovery reinstalls the 
original operating system and software programs that were installed at the factory and then configures 
the settings for the programs. HP Recovery media can also be used to customize the system or restore 
the factory image if you replace the hard drive.
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◦ Only one set of recovery media can be created. Handle these recovery tools carefully, and keep 
them in a safe place.

◦ HP Recovery Manager examines the computer and determines the required storage capacity for 
the media that will be required.

◦ To create recovery discs, your computer must have an optical drive with DVD writer capability, and 
you must use only high-quality blank DVD-R, DVD+R, DVD-R DL, or DVD+R DL discs. Do not use 
rewritable discs such as CD±RW, DVD±RW, double-layer DVD±RW, or BD-RE (rewritable Blu-ray) 
discs; they are not compatible with HP Recovery Manager software. Or, instead, you can use a high-
quality blank USB flash drive.

◦ If your computer does not include an integrated optical drive with DVD writer capability, but you 
would like to create DVD recovery media, you can use an external optical drive (purchased 
separately) to create recovery discs. If you use an external optical drive, it must be connected 
directly to a USB port on the computer; the drive cannot be connected to a USB port on an external 
device, such as a USB hub. If you cannot create DVD media yourself, you can obtain recovery discs 
for your computer from HP. See the Worldwide Telephone Numbers booklet included with the 
computer. You can also find contact information on the HP website. Go to http://www.hp.com/
support, select your country or region, and follow the on-screen instructions.

◦ Be sure that the computer is connected to AC power before you begin creating the recovery media.

◦ The creation process can take an hour or more. Do not interrupt the creation process.

◦ If necessary, you can exit the program before you have finished creating all of the recovery DVDs. 
HP Recovery Manager will finish burning the current DVD. The next time you start HP Recovery 
Manager, you will be prompted to continue.

To create HP Recovery media:

1. Type recovery in the taskbar search box, and then select HP Recovery Manager.

2. Select Create recovery media, and then follow the on-screen instructions.

If you ever need to recover the system, see Recovering using HP Recovery Manager on page 98.

Using Windows tools

You can create recovery media, system restore points, and backups of personal information using Windows 
tools.

NOTE: If storage is 32 GB or less, Microsoft System Restore is disabled by default.

For more information and steps, see Help and Support.

▲ Type help in the taskbar search box, and then select Help and Support.

Restore and recovery

There are several options for recovering your system. Choose the method that best matches your situation 
and level of expertise:

IMPORTANT: Not all methods are available on all products.

● Windows offers several options for restoring from backup, refreshing the computer, and resetting the 
computer to its original state. For more information see Help and Support.
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▲ Type help in the taskbar search box, and then select Help and Support.

● If you need to correct a problem with a preinstalled application or driver, use the Reinstall drivers and/ 
or applications option (select products only) of HP Recovery Manager to reinstall the individual 
application or driver.

▲ Type recovery in the taskbar search box, select HP Recovery Manager, select Reinstall drivers 
and/or applications, and then follow the on-screen instructions.

● If you want to recover the Windows partition to original factory content, you can choose the System 
Recovery option from the HP Recovery partition (select products only) or use the HP Recovery media. 
For more information, see Recovering using HP Recovery Manager on page 98. If you have not already 
created recovery media, see Creating HP Recovery media (select products only) on page 96.

● On select products, if you want to recover the computer's original factory partition and content, or if you 
have replaced the hard drive, you can use the Factory Reset option of HP Recovery media. For more 
information, see Recovering using HP Recovery Manager on page 98.

● On select products, if you want to remove the recovery partition to reclaim hard drive space, HP 
Recovery Manager offers the Remove Recovery Partition option.

For more information, see Removing the HP Recovery partition (select products only) on page 99.

Recovering using HP Recovery Manager

HP Recovery Manager software allows you to recover the computer to its original factory state by using the 
HP Recovery media that you either created or that you obtained from HP, or by using the HP Recovery 
partition (select products only). If you have not already created recovery media, see Creating HP Recovery 
media (select products only) on page 96.

What you need to know before you get started

● HP Recovery Manager recovers only software that was installed at the factory. For software not provided 
with this computer, you must either download the software from the manufacturer's website or reinstall 
the software from the media provided by the manufacturer.

IMPORTANT: Recovery through HP Recovery Manager should be used as a final attempt to correct 
computer issues.

● HP Recovery media must be used if the computer hard drive fails. If you have not already created 
recovery media, see Creating HP Recovery media (select products only) on page 96.

● To use the Factory Reset option (select products only), you must use HP Recovery media. If you have not 
already created recovery media, see Creating HP Recovery media (select products only) on page 96.

● If your computer does not allow the creation of HP Recovery media or if the HP Recovery media does not 
work, you can obtain recovery media for your system from support. See the Worldwide Telephone 
Numbers booklet included with the computer. You can also find contact information from the HP 
website. Go to http://www.hp.com/support, select your country or region, and follow the on-screen 
instructions.

IMPORTANT: HP Recovery Manager does not automatically provide backups of your personal data. Before 
beginning recovery, back up any personal data you want to retain.

Using HP Recovery media, you can choose from one of the following recovery options:

NOTE: Only the options available for your computer display when you start the recovery process.
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● System Recovery—Reinstalls the original operating system, and then configures the settings for the 
programs that were installed at the factory.

● Factory Reset—Restores the computer to its original factory state by deleting all information from the 
hard drive and re-creating the partitions. Then it reinstalls the operating system and the software that 
was installed at the factory.

The HP Recovery partition (select products only) allows System Recovery only.

Using the HP Recovery partition (select products only)

The HP Recovery partition allows you to perform a system recovery without the need for recovery discs or a 
recovery USB flash drive. This type of recovery can be used only if the hard drive is still working.

To start HP Recovery Manager from the HP Recovery partition:

1. Type recovery in the taskbar search box, select Recovery Manager, and then select HP Recovery 
Environment.

- or -

Press f11 while the computer boots, or press and hold f11 as you press the power button.

2. Select Troubleshoot from the boot options menu.

3. Select Recovery Manager, and then follow the on-screen instructions.

Using HP Recovery media to recover

You can use HP Recovery media to recover the original system. This method can be used if your system does 
not have an HP Recovery partition or if the hard drive is not working properly.

1. If possible, back up all personal files.

2. Insert the HP Recovery media, and then restart the computer.

NOTE: If the computer does not automatically restart in HP Recovery Manager, change the computer 
boot order. See Changing the computer boot order on page 99.

3. Follow the on-screen instructions.

Changing the computer boot order

If your computer does not restart in HP Recovery Manager, you can change the computer boot order, which is 
the order of devices listed in BIOS where the computer looks for startup information. You can change the 
selection to an optical drive or a USB flash drive.

To change the boot order:

1. Insert the HP Recovery media.

2. Access BIOS.

Restart the computer, quickly press esc, and then press f9 for boot options.

3. Select the optical drive or USB flash drive from which you want to boot.

4. Follow the on-screen instructions.

Removing the HP Recovery partition (select products only)

HP Recovery Manager software allows you to remove the HP Recovery partition to free up hard drive space.
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IMPORTANT: After you remove the HP Recovery partition, you will not be able to perform System Recovery 
or create HP recovery media from the HP Recovery partition. So before you remove the Recovery partition, 
create HP Recovery media; see Creating HP Recovery media (select products only) on page 96.

NOTE: The Remove Recovery Partition option is only available on products that support this function.

Follow these steps to remove the HP Recovery partition:

1. Type recovery in the taskbar search box, and then select HP Recovery Manager.

2. Select Remove Recovery Partition, and then follow the on-screen instructions.

Backup and recovery in Windows 8.1
To protect your information, use Windows Backup and Restore to back up individual files and folders, back up 
your entire hard drive, create system repair media, or create system restore points. In case of system failure, 
you can use the backup files to restore the contents of your computer.

From the Start screen, type restore, click Settings, and then select from the list of displayed options.

NOTE: For detailed instructions on various backup and restore options, perform a search for these topics in 
Help and Support. From the Start screen, type h, and then select Help and Support.

In case of system instability, HP recommends that you print the recovery procedures and save them for later 
use.

NOTE: Windows includes the User Account Control feature to improve the security of your computer. You 
may be prompted for your permission or password for tasks such as installing software, running utilities, or 
changing Windows settings. Refer to Help and Support for more information. From the Start screen, type h, 
and then select Help and Support.

Backing up your information

Recovery after a system failure is as good as your most recent backup. You should create system repair media 
and your initial backup immediately after initial system setup. As you add new software and data files, you 
should continue to back up your system on a regular basis to maintain a reasonably current backup. The 
system repair media is used to start up (boot) the computer and repair the operating system in case of 
system instability or failure. Your initial and subsequent backups allow you to restore your data and settings 
if a failure occurs.

Type backup on the Start screen, click Settings, and then select Save backup copies of your files with File 
History.

You can back up your information to an optional external hard drive, or a network drive.

Note the following when backing up:

● Store personal files in the Documents library, and back it up regularly.

● Back up templates that are stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot of your 
settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a backup using Backup and Restore:

NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the computer.
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1. From the Start screen, type backup, click Settings, and then select from the list of displayed options.

2. Follow the on-screen instructions to set up your backup, create a system image, or create system repair 
media.

Performing a system recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools: You can use Windows Backup and Restore to recover information you have 
previously backed up. You can also use Windows Automatic Repair to fix problems that might prevent 
Windows from starting correctly.

● f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image. The 
image includes the Windows operating system and software programs installed at the factory.

NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair media you 
previously created, you must purchase Windows 8.1 operating system media to reboot the computer and 
repair the operating system. For additional information, see Using Windows 8.1 operating system media 
(purchased separately) on page 102.

Using the Windows recovery tools

To recover information you previously backed up:

▲ From the Start screen, type h, and then select Help and Support.

To recover your information using Automatic Repair, follow these steps:

CAUTION: Some Automatic Repair options will completely erase and reformat the hard drive. For additional 
information go to Help and Support. From the Start screen, type h, and then select Help and Support.

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition and the Windows partition:

From the Start screen, type e, and then click Windows Explorer.

– or –

From the Start screen, type c, and then select Computer.

NOTE: If the Windows partition and the HP Recovery partition are not listed, you must recover your 
operating system and programs using the Windows 8.1 operating system media and the Driver Recovery 
media (both purchased separately). For additional information, see Using Windows 8.1 operating system 
media (purchased separately) on page 102.

3. If the Windows partition and the HP Recovery partition are listed, restart the computer after Windows 
has loaded, and then press and hold Shift while clicking Restart.

NOTE: If the computer fails to boot to Windows after several attempts, the system will boot to the 
Windows Recovery Environment by default.

4. Select Troubleshoot, select Advanced Options, and then select Automatic Repair.

5. Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a search for 
these topics in Help and Support. From the Start screen, type h, and then select Help and Support.
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Using f11 recovery tools

CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files that you 
have created and any software that you have installed on the computer are permanently removed. The f11 
recovery tool reinstalls the operating system and HP programs and drivers that were installed at the factory. 
Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition: From the Start screen, type C, and then 
select Computer.

NOTE: If the HP Recovery partition is not listed, you must recover your operating system and programs 
using the Windows 8.1 operating system media, and the Driver Recovery media (both purchased 
separately). For additional information, see Using Windows 8.1 operating system media (purchased 
separately) on page 102.

3. If the HP Recovery partition is listed, restart the computer, and then press esc while the company logo is 
displayed. The computer Startup Menu displays.

4. Press f11 to select the System Recovery option.

5. Follow the on-screen instructions.

Using Windows 8.1 operating system media (purchased separately)

To order Windows 8.1 operating system media, go to http://www.hp.com/support, select your country or 
region, and follow the on-screen instructions. You can also order the media by calling support.

CAUTION: Using Windows 8.1 operating system media completely erases hard drive contents and reformats 
the hard drive. All files that you have created and any software that you have installed on the computer are 
permanently removed. When reformatting is complete, the recovery process helps you restore the operating 
system, as well as drivers, software, and utilities.

To initiate recovery using Windows 8.1 operating system media:

NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then follow the instructions provided with the Windows 8.1 operating system 
media to install the operating system.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

After the repair is completed:

1. Remove the Windows 8.1 operating system media, and then insert the Driver Recovery media.

2. Install the Hardware Enabling Drivers first, and then install Recommended Applications.
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10 POST Error Messages

This appendix lists the error codes, error messages, and the various indicator light and audible sequences 
that you may encounter during Power-On Self-Test (POST) or computer restart, the probable source of the 
problem, and steps you can take to resolve the error condition.

POST Message Disabled suppresses most system messages during POST, such as memory count and non-
error text messages. If a POST error occurs, the screen will display the error message. To manually switch to 
the POST Messages Enabled mode during POST, press any key (except F10, F11, or F12). The default mode is 
POST Message Disabled.

The speed at which the computer loads the operating system and the extent to which it is tested are 
determined by the POST mode selection.

Full Boot may also be enabled to run every 1 to 30 days on a regularly scheduled basis. To establish the 
schedule, reconfigure the computer to the Full Boot Every x Days mode, using Computer Setup.

POST Numeric Codes and Text Messages
This section covers those POST errors that have numeric codes associated with them. The section also 
includes some text messages that may be encountered during POST.

NOTE: The computer will beep once after a POST text message is displayed on the screen.

Table 10-1  Numeric Codes and Text Messages

Control panel message Description Recommended action

101-Option ROM Checksum Error System ROM checksum. 1. Verify the correct ROM.

2. Flash the ROM if needed.

3. Clear CMOS (See Appendix B, Password 
Security and Resetting CMOS 
on page 111.)

4. Replace the system board.

103-System Board Failure DMA or timers. 1. Clear CMOS (See Appendix B, Password 
Security and Resetting CMOS 
on page 111.)

2. Replace the system board.

162-System Options Not Set Configuration incorrect.

RTC (real-time clock) battery may need to 
be replaced.

Run Computer Setup and check the 
configuration in Advanced > Onboard Devices.

Reset the date and time under Control Panel. If 
the problem persists, replace the RTC battery. 
See the Removal and Replacement section for 
instructions on installing a new battery, or 
contact an authorized dealer or reseller for RTC 
battery replacement.

163-Time & Date Not Set Invalid time or date in configuration memory.

RTC (real-time clock) battery may need to 
be replaced.

Reset the date and time under Control Panel 
(Computer Setup can also be used). If the 
problem persists, replace the RTC battery. See 
the Removal and Replacement section for 
instructions on installing a new battery, or 
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Table 10-1  Numeric Codes and Text Messages (continued)

Control panel message Description Recommended action

contact an authorized dealer or reseller for RTC 
battery replacement.

163-Time & Date Not Set CMOS jumper may not be properly installed. Check for proper placement of the CMOS jumper 
if applicable.

164-MemorySize Error Memory amount has changed since the last 
boot (memory added or removed).

Press the F1 key to save the memory changes.

164-MemorySize Error Memory configuration incorrect. 1. Run Computer Setup or Windows utilities.

2. Make sure the memory module(s) are 
installed properly.

3. If third-party memory has been added, 
test using HP-only memory.

4. Verify proper memory module type.

201-Memory Error RAM failure. 1. Ensure memory modules are correctly 
installed.

2. Verify proper memory module type.

3. Remove and replace the identified faulty 
memory module(s).

4. If the error persists after replacing 
memory modules, replace the system 
board.

213-Incompatible Memory Module in Memory 
Socket(s) X, X, ...

A memory module in memory socket identified 
in the error message is missing critical SPD 
information, or is incompatible with the chipset.

1. Verify proper memory module type.

2. Try another memory socket.

3. Replace SODIMM with a module 
conforming to the SPD standard.

214-SODIMM Configuration Warning Populated SODIMM Configuration is not 
optimized.

Populate the SODIMMs so that each channel has 
the same amount of memory.

219-ECC Memory Module Detected ECC Modules 
not supported on this Platform

Recently added memory module(s) support ECC 
memory error correction.

1. If additional memory was recently added, 
remove it to see if the problem remains.

2. Check product documentation for 
memory support information.

301-Keyboard Error Keyboard failure. 1. Reconnect keyboard with computer 
turned off.

2. Check connector for bent or missing pins.

3. Ensure that none of the keys are 
depressed.

4. Replace keyboard.

303-Keyboard Controller Error I/O board keyboard controller. 1. Reconnect keyboard with computer 
turned off.

2. Replace the system board.

304-Keyboard or System Unit Error Keyboard failure. 1. Reconnect the keyboard with computer 
turned off.

2. Ensure that none of the keys are 
depressed.
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Table 10-1  Numeric Codes and Text Messages (continued)

Control panel message Description Recommended action

3. Replace the keyboard.

4. Replace the system board.

510-Flash Screen Image Corrupted Flash Screen image has errors. Reflash the system ROM with the latest BIOS 
image.

511-CPU, CPUA, or CPUB Fan not Detected CPU fan is not connected or may have 
malfunctioned.

1. Reseat CPU fan.

2. Reseat fan cable.

3. Replace CPU fan.

512-Chassis, Rear Chassis, or Front Chassis Fan 
not Detected

Fan is not connected or may have 
malfunctioned.

1. Reseat fan.

2. Reseat fan cable.

3. Replace fan.

660-Display cache is detected unreliable Integrated graphics controller display cache is 
not working properly and will be disabled.

Replace system board if minimal graphics 
degrading is an issue.

1151-Serial Port A Address Conflict Detected Both external and internal serial ports are 
assigned to COM1.

1. Clear CMOS (See Appendix B, Password 
Security and Resetting CMOS 
on page 111.)

2. Reconfigure card resources and/or run 
Computer Setup or Windows utilities.

1152-Serial Port B Address Conflict Detected Both external and internal serial ports are 
assigned to COM2.

1. Clear CMOS (See Appendix B, Password 
Security and Resetting CMOS 
on page 111.)

2. Reconfigure card resources and/or run 
Computer Setup or Windows utilities.

1155-Serial Port Address Conflict Detected Both external and internal serial ports are 
assigned to same IRQ.

1. Clear CMOS (See Appendix B, Password 
Security and Resetting CMOS 
on page 111.)

2. Reconfigure card resources and/or run 
Computer Setup or Windows utilities.

1720-SMART Hard Drive Detects Imminent 
Failure

Hard drive is about to fail. (Some hard drives 
have a hard drive firmware patch that will fix an 
erroneous error message.)

1. Determine if hard drive is giving correct 
error message. Run the Drive Protection 
System test using F2 Diagnostics.

2. Apply hard drive firmware patch 
if applicable. (Available at 
http://www.hp.com/support.)

3. Back up contents and replace hard drive.

1796-SATA Cabling Error One or more SATA devices are improperly 
attached. For optimal performance, the SATA 0 
and SATA 1 connectors must be used before 
SATA 2.

Ensure SATA connectors are used in ascending 
order. For one device, use SATA 0. For two 
devices, use SATA 0 and SATA 1. For three 
devices, use SATA 0, SATA 1, and SATA 2.

1797-SATA Drivelock is not supported in RAID 
mode.

Drivelock is enabled on one or more SATA hard 
drives, and they cannot be accessed while the 
system is configured for RAID mode.

Either remove the Drivelocked SATA device or 
disable the Drivelock feature. To disable the 
Drivelock feature, enter Computer Setup, 
change Storage > Storage Options > SATA 
Emulation to IDE, and select File > Save 
Changes and Exit. Reenter Computer Setup and 
select Security > Drivelock Security. For each 
listed Drivelock-capable SATA device, ensure 
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Table 10-1  Numeric Codes and Text Messages (continued)

Control panel message Description Recommended action

Drivelock is Disabled. Lastly, change Storage > 
Storage Options > SATA Emulation back to 
RAID and select File > Save Changes and Exit.

1801-Microcode Patch Error Processor is not supported by ROM BIOS. ▲ Upgrade BIOS to proper version.

2200-PMM Allocation Error during MEBx 
Download

Memory error during POST execution of the 
Management Engine (ME) BIOS Extensions 
option ROM.

1. Reboot the computer.

2. Unplug the power cord, re-seat the 
memory modules, and reboot the 
computer.

3. If the memory configuration was recently 
changed, unplug the computer, restore 
the original memory configuration, and 
reboot the computer.

4. If the error persists, replace the system 
board.

2201-MEBx Module did not checksum correctly Memory error during POST execution of the 
Management Engine (ME) BIOS Extensions 
option ROM.

1. Reboot the computer.

2. Unplug the power cord, re-seat the 
memory modules, and reboot the 
computer.

3. If the memory configuration was recently 
changed, unplug the power cord, restore 
the original memory configuration, and 
reboot the computer.

4. If the error persists, replace the system 
board.

2202-PMM Deallocation Error during MEBx 
cleanup

Memory error during POST execution of the 
Management Engine (ME) BIOS Extensions 
option ROM.

1. Reboot the computer.

2. Unplug the power cord, re-seat the 
memory modules, and reboot the 
computer.

3. If the memory configuration was recently 
changed, unplug the power cord, restore 
the original memory configuration, and 
reboot the computer.

4. If the error persists, replace the system 
board.

2203-Setup error during MEBx execution MEBx selection or exit resulted in a setup 
failure.

1. Reboot the computer.

2. Unplug the power cord, re-seat the 
memory modules, and reboot the 
computer.

3. If the memory configuration was recently 
changed, unplug the power cord, restore 
the original memory configuration, and 
reboot the computer.

4. If the error persists, replace the system 
board.

2204-Inventory error during MEBx execution BIOS information passed to the MEBx resulted 
in a failure.

1. Reboot the computer.

2. If the error persists, update to the latest 
BIOS version.
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Table 10-1  Numeric Codes and Text Messages (continued)

Control panel message Description Recommended action

3. If the error still persists, replace the 
system board.

2205-Interface error during MEBx execution MEBx operation experienced a hardware error 
during communication with ME.

1. Reboot the computer.

2. If the error persists, update to the latest 
BIOS version.

3. If the error still persists, replace the 
system board.

2211-Memory not configured correctly for 
proper MEBx execution.

SODIMM1 or XMM1 is not installed. Make sure there is a memory module in the 
black SODIMM1 socket and that it is properly 
seated.

2212-USB Key Provisioning failure writing to 
device

USB device used for USB key provisioning will 
not allow BIOS to update provision file properly.

1. Try a different USB key device for 
provisioning.

2. If the error persists, update to the latest 
BIOS version and ME firmware version.

3. If the error still persists, replace the 
system board.

2217-ME Firmware Version request failure ME firmware is not properly responding to BIOS 
query for version information.

1. Reboot the computer.

2. If the error persists, update to the latest 
BIOS version and ME firmware version.

3. If the error still persists, replace the 
system board.

2218-ME Firmware Version should be updated ME firmware must be updated to match current 
functionality contained in the system BIOS.

1. Update to the latest ME firmware version.

2. If the error persists and system BIOS has 
been recently updated, restore previous 
system BIOS version.

3. If the error still persists, replace the 
system board.

2219-USB Key Provisioning file has invalid 
header identifier

Provisioning file contained on the USB key has 
been corrupted or is not a valid version for the 
current ME firmware.

1. Recreate the provisioning file using third 
party management console software.

2. If the error persists and system BIOS has 
been recently updated, restore previous 
system BIOS version. Otherwise, update 
the ME firmware version.

3. If the error still persists, replace the 
system board.

2220-USB Key Provisioning file has mismatch 
version

Provisioning file contained on the USB key is not 
a valid version for the current ME firmware.

1. Reboot the computer.

2. If the error persists and system BIOS has 
been recently updated, restore previous 
system BIOS version. Otherwise, update 
the ME firmware version.

3. If the error still persists, replace the 
system board.

2230-General error during MEBx execution Error occurred during MEBx execution which 
fails into the “General” grouping. Status 
information displayed along with the error 
provides further clarity into the failure. MEBx 

1. Reboot the computer.

2. If the error persists, update to the latest 
BIOS version and ME firmware version.
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Table 10-1  Numeric Codes and Text Messages (continued)

Control panel message Description Recommended action

handles transference of information between 
the system BIOS and ME firmware.

3. If the error still persists, replace the 
system board.

2231-ME error during MEBx execution Error occurred during MEBx execution which 
fails into “ME” grouping.

1. Reboot the computer.

2. If the error persists, update to the latest 
BIOS version and ME firmware version.

3. If the error still persists, replace the 
system board.

2232-AMT error during MEBx execution Error occurred during MEBx execution which 
fails into “AMT” grouping.

1. Reboot the computer.

2. If the error persists, update to the latest 
BIOS version and ME firmware version.

3. If the error still persists, replace the 
system board.

2233-HECI error during MEBx execution Error occurred during MEBx execution which 
fails into “MEI or HECI” grouping.

1. Reboot the computer.

2. If the error persists, update to the latest 
BIOS version and ME firmware version.

3. If the error still persists, replace the 
system board.

2239-ME image lock failure Special system configurations with reduced ME 
firmware image require BIOS control of ME 
firmware upgrading. A failure has occurred 
after the ME firmware update process in which 
the BIOS could not relock the ME firmware 
region.

1. Reboot the computer.

2. If the error persists, update to the latest 
BIOS version and ME firmware version.

3. If the error still persists, replace the 
system board.

2240-ME image unlock failure Special system configurations with reduced ME 
firmware image require BIOS control of ME 
firmware upgrading. A failure has occurred prior 
to the ME firmware update process in which the 
BIOS could not unlock the ME firmware region.

1. Reboot the computer.

2. If the error persists, update to the latest 
BIOS version and ME firmware version.

3. If the error still persists, replace the 
system board.

Invalid Electronic Serial Number Electronic serial number is missing. Enter the correct serial number in Computer 
Setup.

Network Server Mode Active and No Keyboard 
Attached

Keyboard failure while Network Server Mode 
enabled.

1. Reconnect keyboard with computer 
turned off.

2. Check connector for bent or missing pins.

3. Ensure that none of the keys are 
depressed.

4. Replace keyboard.

Parity Check 2 Parity RAM failure. Run Computer Setup and Diagnostic utilities.
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Interpreting POST diagnostic front panel LEDs
This section covers the front panel LED codes as well as the audible codes that may occur before or during 
POST that do not necessarily have an error code or text message associated with them.

WARNING! When the computer is plugged into an AC power source, voltage is always applied to the system 
board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be sure to disconnect 
the power cord from the wall outlet and allow the internal system components to cool before touching.

NOTE: If you see flashing LEDs on a PS/2 keyboard, look for flashing LEDs on the front panel of the 
computer and refer to the following table to determine the front panel LED codes.

Recommended actions in the following table are listed in the order in which they should be performed.

Not all diagnostic lights and audible codes are available on all models.

Table 10-2  Diagnostic front panel LEDs and audible codes

Activity Beeps Possible Cause Recommended Action

White Power LED On. None Computer on. None

White Power LED flashes every 
two seconds.

None Computer in Suspend to 
RAM mode (some models 
only) or normal Suspend 
mode.

None required. Press any key or move the mouse to 
wake the computer.

Red Power LED flashes two 
times, once every second, 
followed by a two second pause. 
Beeps stop after fifth iteration 
but LEDs continue until problem 
is solved.

2 Processor thermal 
protection activated:

A fan may be blocked or not 
turning.

OR

The heat sink/fan assembly 
is not properly attached to 
the processor.

1. Ensure that the computer air vents are not 
blocked and the processor cooling fan is 
running.

2. Remove access panel, press power button, and 
see if the fan spins. If the fan is not spinning, 
make sure the fan's cable is plugged onto the 
system board header.

3. If fan is plugged in, but is not spinning, then 
replace fan assembly.

4. Contact an authorized reseller or service 
provider.

Red Power LED flashes five 
times, once every second, 
followed by a two second pause. 
Beeps stop after fifth iteration 
but LEDs continue until problem 
is solved.

5 Pre-video memory error. CAUTION: To avoid damage to the SODIMMs or the 
system board, you must unplug the computer power 
cord before attempting to reseat, install, or remove a 
SODIMM module.

1. Reseat SODIMMs.

2. Replace SODIMMs one at a time to isolate the 
faulty module.

3. Replace third-party memory with HP memory.

4. Replace the system board.

Red Power LED flashes six times, 
once every second, followed by a 
two second pause. Beeps stop 
after fifth iteration but LEDs 
continue until problem is solved.

6 Pre-video graphics error. Replace the system board.

Red Power LED flashes seven 
times, once every second, 
followed by a two second pause. 
Beeps stop after fifth iteration 

7 System board failure (ROM 
detected failure prior to 
video).

Replace the system board.
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Table 10-2  Diagnostic front panel LEDs and audible codes (continued)

Activity Beeps Possible Cause Recommended Action

but LEDs continue until problem 
is solved.

Red Power LED flashes eight 
times, once every second, 
followed by a two second pause. 
Beeps stop after fifth iteration 
but LEDs continue until problem 
is solved.

8 Invalid ROM based on bad 
checksum.

1. Reflash the system ROM with the latest BIOS 
image. See the “Boot Block Emergency 
Recovery Mode” section of the Desktop 
Management Guide for more information.

2. Replace the system board.

Red Power LED flashes nine 
times, once every second, 
followed by a two second pause. 
Beeps stop after fifth iteration 
but LEDs continue until problem 
is solved.

9 System powers on but is 
unable to boot.

1. Unplug the AC power cord from the computer, 
wait 30 seconds, then plug the power cord back 
in to the computer.

2. Replace the system board.

System does not power on and 
LEDs are not flashing.

None System unable to power on. Press and hold the power button for less than 4 
seconds. If the hard drive LED turns green, the power 
button is working correctly. Try the following:

▲ Replace the system board.

OR

Press and hold the power button for less than 4 
seconds. If the hard drive LED does not turn on green 
then:

1. Check that the unit is plugged into a working AC 
outlet.

2. Open rear cover and check that the power 
button cable is properly connected to the 
system board.

3. Check to see if the 5V_aux light on the system 
board is turned on. If it is turned on, then 
replace the power button board and cable. If 
the problem persists, replace the system 
board.

4. Replace the AC adapter.
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11 Password Security and Resetting CMOS

This computer supports security password features, which can be established through the Computer Setup 
Utilities menu.

This computer supports two security password features that are established through the Computer Setup 
Utilities menu: setup password and power-on password. When you establish only a setup password, any user 
can access all the information on the computer except Computer Setup. When you establish only a power-on 
password, the power-on password is required to access Computer Setup and any other information on the 
computer. When you establish both passwords, only the setup password will give you access to Computer 
Setup.

When both passwords are set, the setup password can also be used in place of the power-on password as an 
override to log in to the computer. This is a useful feature for a network administrator.

If you forget the password for the computer, you can clear that password so you can gain access to the 
information on the computer by resetting the password jumper.

CAUTION: Pushing the CMOS button will reset CMOS values to factory defaults. It is important to back up the 
computer CMOS settings before resetting them in case they are needed later. Back up is easily done through 
Computer Setup. See Computer Setup (F10) Utility on page 50 for information.

CAUTION: If you enable the stringent security feature in Computer Setup and you forget the setup password 
or the power-on password, the computer is inaccessible and can no longer be used.

Enabling the stringent password disables the ability to reset the password by moving the jumper on the 
system board.

If you lose or forget the password, the system board must be replaced. This scenario is not covered under 
warranty.

To prevent the computer from becoming permanently unusable, record your configured setup password or 
power-on password in a safe place away from your computer. Without these passwords, the computer cannot 
be unlocked.

Establishing a Setup or Power-on password
To establish the power-on or setup password features, complete the following steps:

1. Turn on or restart the computer.

2. As soon as the computer turns on, press the Esc key while “Press the ESC key for Startup Menu” 
message is displayed at the bottom of the screen.

3. Press the F10 key to enter Computer Setup.

4. To establish Setup password, select Security > Setup Password and follow the instructions.

– or –

To establish a Power-On password, select Security > Power-On Password and follow the instructions on 
the screen

5. Before exiting, click File > Save Changes and Exit.
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Resetting the Setup and Power-on password
To disable the power-on or setup password features, or to clear the power-on or setup passwords, complete 
the following steps:

1. Shut down the operating system properly, then turn off the computer and any external devices, and 
disconnect the power cord from the power outlet.

2. With the power cord disconnected, press the power button again to drain the system of any residual 
power.

WARNING! To reduce the risk of personal injury from electrical shock and/or hot surfaces, be sure to 
disconnect the power cord from the wall outlet, and allow the internal system components to cool 
before touching.

CAUTION: When the computer is plugged in, the power supply always has voltage applied to the 
system board even when the unit is turned off. Failure to disconnect the power cord can result in 
damage to the system.

Static electricity can damage the electronic components of the computer or optional equipment. Before 
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a 
grounded metal object. See the Regulatory, Safety and Environmental Notices guide for more 
information.

3. Remove the access panel.

4. Locate the header and jumper labeled PSWD.

NOTE: The password jumper is blue so that it can be easily identified. For assistance locating the 
password jumper and other system board components, see the Illustrated Parts & Service Map (IPSM). 
The IPSM can be downloaded from http://www.hp.com/support.

5. Remove the jumper.

6. Replace the jumper.

7. Replace the access panel.

8. Reconnect the external equipment.

9. Plug in the computer and turn on power. Allow the operating system to start. This clears the current 
passwords and disables the password features.

10. Establish the new passwords in Computer Setup. See Computer Setup (F10) Utility on page 50 for 
information.

Clearing and resetting the CMOS
The computer’s configuration memory (CMOS) stores information about the computer’s configuration.

The CMOS button resets CMOS but does not clear the power-on and setup passwords.

Clearing CMOS will clear the Active Management Technology (AMT) settings in the Management Engine BIOS 
Extension (MEBx), including the password. The password will default to “admin” and will need to be reset. The 
AMT settings will also need to be reset. To access the MEBx, press Ctrl+P during POST.
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1. Turn off the computer and any external devices, and disconnect the power cord from the power outlet.

2. Disconnect external equipment connected to the computer.

WARNING! To reduce the risk of personal injury from electrical shock and/or hot surfaces, be sure to 
disconnect the power cord from the wall outlet, and allow the internal system components to cool 
before touching.

CAUTION: When the computer is plugged in, the power supply always has voltage applied to the 
system board even when the unit is turned off. Failure to disconnect the power cord can result in 
damage to the system.

Static electricity can damage the electronic components of the computer or optional equipment. Before 
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a 
grounded metal object. See the Safety & Regulatory Information guide for more information.

3. Remove the computer cover or access panel.

CAUTION: Pushing the CMOS button will reset CMOS values to factory defaults. It is important to back 
up the computer CMOS settings before resetting them in case they are needed later. Back up is easily 
done through Computer Setup. See Computer Setup (F10) Utility on page 50 for information on backing 
up the CMOS settings.

4. Locate, press, and hold the CMOS button in for five seconds.

NOTE: Make sure you have disconnected the AC power cord from the wall outlet. The CMOS button will 
not clear CMOS if the power cord is connected.

Figure 11-1  CMOS button

NOTE: For assistance locating the CMOS button and other system board components, see the 
Illustrated Parts & Service Map (IPSM).

5. Replace the computer cover or access panel.

6. Reconnect the external devices.

7. Plug in the computer and turn on power.
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NOTE: You will receive POST error messages after clearing CMOS and rebooting advising you that 
configuration changes have occurred. Use Computer Setup to reset any special system setups along with 
the date and time.

For instructions on Computer Setup, see Computer Setup (F10) Utility on page 50.
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A Power Cord Set Requirements

The power supplies on some computers have external power switches. The voltage select switch feature on 
the computer permits it to operate from any line voltage between 100-120 or 220-240 volts AC. Power 
supplies on those computers that do not have external power switches are equipped with internal switches 
that sense the incoming voltage and automatically switch to the proper voltage.

The power cord set received with the computer meets the requirements for use in the country where you 
purchased the equipment.

Power cord sets for use in other countries must meet the requirements of the country where you use the 
computer.

General requirements
The requirements listed below are applicable to all countries:

1. The power cord must be approved by an acceptable accredited agency responsible for evaluation in the 
country where the power cord set will be installed.

2. The power cord set must have a minimum current capacity of 10A (7A Japan only) and a nominal voltage 
rating of 125 or 250 volts AC, as required by each country’s power system.

3. The diameter of the wire must be a minimum of 0.75 mm2 or 18AWG, and the length of the cord must be 
between 1.8 m (6 feet) and 3.6 m (12 feet).

The power cord should be routed so that it is not likely to be walked on or pinched by items placed upon it or 
against it. Particular attention should be paid to the plug, electrical outlet, and the point where the cord exits 
from the product.

WARNING! Do not operate this product with a damaged power cord set. If the power cord set is damaged in 
any manner, replace it immediately.

Japanese Power Cord Requirements
For use in Japan, use only the power cord received with this product.

CAUTION: Do not use the power cord received with this product on any other products.
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Country-specific requirements
Additional requirements specific to a country are shown in parentheses and explained below.

Country Accrediting Agency  Country Accrediting Agency

Australia (1)

Austria (1)

Belgium (1)

Canada (2)

EANSW

OVE

CEBC

CSA

 Italy (1)

Japan (3)

Norway (1)

Sweden (1)

IMQ

METI

NEMKO

SEMKO

Denmark (1)

Finland (1)

France (1)

Germany (1)

DEMKO

SETI

UTE

VDE

 Switzerland (1)

United Kingdom (1)

United States (2)

SEV

BSI

UL

1. The flexible cord must be Type HO5VV-F, 3-conductor, 0.75mm2 conductor size. Power cord set fittings (appliance coupler and 
wall plug) must bear the certification mark of the agency responsible for evaluation in the country where it will be used.

2. The flexible cord must be Type SVT or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole grounding type 
with a NEMA 5-15P (15A, 125V) or NEMA 6-15P (15A, 250V) configuration.

3. Appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the Japanese 
Dentori Law. Flexible cord must be Type VCT or VCTF, 3-conductor, 0.75 mm2 conductor size. Wall plug must be a two-pole 
grounding type with a Japanese Industrial Standard C8303 (7A, 125V) configuration.
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B Specifications

Specifications

Dimensions

Height

Width

Depth

12.96 in

18.51 in

2.83 in

329 mm

470 mm

72 mm

Approximate Weight (with stand)
12 lbs 5.5 kg

Temperature Range

Operating

Nonoperating

41° to 95°F

-22° to 149°F

5° to 35°C

-30° to 65°C

Relative Humidity (non-condensing)

Operating 15-80% 15-80%

Maximum Altitude (unpressurized)

Operating

Non-operating

0 - 6,500 ft

0 - 15,000 ft

0 - 2,000 m

4,572 m

Power Supply

Rated Voltage Range

Rated Line Frequency

100-240 V

50-60 Hz, 2.0 A

Max Operating Power < 90 W

Idle Operating Power 30 W
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